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Notice

The company reserves the right to revise this publication or to change its contents without notice. Infor-
mation contained herein is for reference only and does not constitute a commitment on the part of the man-
ufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or
inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage
resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated,
transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer
or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered
trademarks of their respective companies. They are mentioned for identification purposes only and are not
intended as an endorsement of that product or its manufacturer.

©March 2004

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain
U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights
owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and
is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Cor-
poration. Reverse engineering or disassembly is prohibited.

Intel and Pentium are registered trademarks of Intel Corporation.
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FCC Statement

(Federal Communications Commission)

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

* Re orient or relocate the receiving antenna.

» Increase the separation between the equipment and receiver.

* Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
* Consult the service representative or an experienced radio/TV technician for help.
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Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifica-
tions not expressly approved by the manufacturer for compliance with the above standards could void your au-

thority to operate the equipment.
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IMPORTANT SAFETY INSTRUCTIONS

When using your telephone equipment, basic safety precautions should always be followed to reduce the
risk of fire, electric shock and injury to persons, including the following:

1.

2.

Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub,
in a wet basement or near a swimming pool.

Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm.
There may be a remote risk of electrical shock from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They
may explode. Check with local codes for possible special disposal instructions.

This product is intended to be supplied by a Listed Power Unit (DC Output 20V, 3.25A minimum).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equip-
ment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER,

TELECOMMUNICATION LINE CORD
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be

damaged.

Do not expose the computer
to any shock or vibration.

Do not place it on an unstable
surface.

Do not place anything heavy
on the computer.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of
heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer
could be badly damaged.

Do not expose it to excessive
heat or direct sunlight.

A
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Do not leave it in a place
where foreign matter or mois-
ture may affect the system.

Don 't use or store the com-
puter in a humid environment.

e lfs
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Do not place the computer on
any surface that will block the
vents.




Preface

3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and
other strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and
don’t forget to save your work. Remember to periodically save your data as data may be lost if the

battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is

on.

Do not disassemble the com-
puter by yourself.
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Perform routine maintenance
on your computer.

5. Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.
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Power Safety
The computer has specific power requirements:

NV * Only use a power adapter approved for use with this computer.

7£l< * Your AC adapter may be designed for international travel but it still requires a
Power Safety steady, uninterrupted power supply. If you are unsure of your local power specifi-

Warning cations, consult your service representative or local power company.

Before you undertake * The power adapter may have either a 2-prong or a 3-prong grounded plug. The

any upgrade proce- third prong is an important safety feature; do not defeat its purpose. If you do not

dures, make sure that have access to a compatible outlet, have a qualified electrician install one.

you have turned off the * When you want to unplug the power cord, be sure to disconnect it by the plug head,

] o o i

and cablesp (inzlu ding * Make sure the socket and any extension cord(s) you use can support the total cur-

telephone lines). It is rent load of all the connected devices.

advisable to also re- » Before cleaning the computer, make sure it is disconnected from any external

move your battery in power supplies (i.e. AC adapter or car adapter).

order to prevent acci-

dentally turning the

machine on.

Do not plug in the power Do not use the power cord if | Do not place heavy objects
cord if you are wet. it is broken. on the power cord.
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Battery Precautions

* Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the com-
puter.

* Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

* Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative
or qualified service personnel.

* Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully.
Batteries may explode or leak if exposed to fire, or improperly handled or discarded.

* Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

* Do not touch the battery contacts with your hands or metal objects.

>N\
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Battery Disposal

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of
its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal
waste stream. Check with your local solid waste officials for details in your area for recycling options or proper
disposal.

Caution

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommend-
ed by the manufacturer. Discard used battery according to the manufacturer’s instructions.

VIl



Preface

Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer

from the power supply. Then refer servicing to qualified service personnel under any of the following con-
ditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

» If the computer has been exposed to rain or other liquids.

» If the computer does not work normally when you follow the operating instructions.

» If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
» If there is an unusual odor, heat or smoke coming from your computer.

VIl
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Travel Considerations

Packing

As you get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC adapter and cables. Stow them in the carrying bag.

The AC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter.
However, check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those
devices’ adapters and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership
for both hardware and software.

abownN =

No
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Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container).
Putting a notebook which is powered on in a travel bag may cause the vents/intakes to be blocked. To prevent

your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshoot-
ing, keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is
very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful.
Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the
computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your
computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to
turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in
flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead com-
partment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC adapter and keep your bat-
tery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the
computer. Wait a few minutes before turning it on so that any moisture can evaporate.
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Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods
of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your
hands, wrists or other joints. The following are some tips to reduce the strain:

* Adjust the height of the chair and/or desk so that the keyboard is at or slightly
below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed
position.

*  Your knees should be slightly higher than your hips. Place your feet flat on the
floor or on a footrest if necessary.

» Use a chair with a back and adjust it to support your lower back comfortably.

 Sit straight so that your knees, hips and elbows form approximately 90-degree
angles when you are working.

» Take periodic breaks if you are using the computer for long periods of time.

Remember to:

» Alter your posture frequently.

» Stretch and exercise your body several times a day.

» Take periodic breaks when you work at the computer for long periods of time. Fre-
quent and short breaks are better than fewer and longer breaks.

Xl
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your
neck and shoulders.

* Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

* Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen
clearly.

* Position the display directly in front of you at a comfortable viewing distance.

* Adjust the display-viewing angle to find the best position.

Xl
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Chapter 1: Introduction

Overview

This manual refers to the hardware and essential software required to run your
notebook computer. Depending on how your system is configured, some or all
of the features described may already be set up. This chapter covers:

* The Manual — how to use it
* System Map — navigating around your computer

Advanced Users

If you are an advanced user you may skip over most of this manual. However
you may find it useful to refer to “What to Install” on page 4 - 2, “BIOS Util-
ities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1. You may
also find the notes marked with a 2 of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them)
then you should try to look through all the documentation. Do not worry if you
do not understand everything the first time. Keep this manual nearby and refer
to it to learn as you go. You may find it useful to refer to the notes marked with
a /2 as indicated in the margin.

Introduction a

4

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features.

Overview 1 - 1
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Warning Boxes

No matter what your level please pay careful attention to the warning and safe-
ty information indicated by the Z0& symbol. Also please note the safety and
handling instructions as indicated in the Preface.

Not Included

Operating Systems (e.g. Windows 2000 Professional, Windows XP etc.) have
their own manuals, as do applications (e.g. word processing, spreadsheet and
database programs). If you have questions about the operating systems or pro-
grams then please consult the appropriate manuals.

System Software

Your computer may already come with system software pre-installed. Where
this is not the case, or where you are re-configuring your computer for a dif-
ferent system, you will find this manual refers to the following operating sys-
tems:

*  Microsoft Windows 2000
*  Microsoft Windows XP (Home & Professional Editions)

. |
1 - 2 Overview
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Quick Start Guide
4

This guide assumes that you are already familiar with computers and can tell

at a glance what and where all the key components are. If you are not that com- Peripheral Devices
fort.able.with this type of device, then please refer to the following pages, Please note that pe-
which give an overview of the system. ripherals (printers, dig-
ital cameras, etc.)
It is still best to review these steps, before taking any action. If there is any- which tattacg to };gur
thing you are not sure about, then please refer to the appropriate chapter before fggpu irr IéEEe1I 3: ;

continuing. ports may be connect-

ed after Windows is
Unless you need to install an operating system, your computer should be ready up and running. All oth-
to work right out of the box. Before you begin please follow the safety instruc- er peripherals must be

. . connected before you
tions in the Preface. turn on the system.

1.  Remove all packing materials.

2. Securely attach any peripherals you want to use with the notebook (e.g.
keyboard and mouse) to their ports.

3. Attach the AC adapter to the DC-in jack on the right of the computer (see

“Right Side View” on page 1 - 17), then plug the AC power cord into an

outlet, and connect the AC power cord to the AC adapter.

Raise the lid/LCD to a comfortable viewing angle.

5. Press the power button to turn “on”.

B

Quick Start Guide 1 - 3
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System Map

Your computer has a lot of built-in features. Most of these are enabled by your
operating system. Further explanations of the various subsystems are covered
in the chapter or pages indicated.

Model Differences

This notebook series includes two different model types according to the pro-
cessor and Wireless LAN module specifications. You can identify if your
computer is Model A or Model B by checking the POST screen as the com-
puter starts up, and by referring to Table 1 - 1, “Model Differences,” on
page 1-5. In addition to the two model types, there are also two different de-
signs (see Figure I - 1) as illustrated on page 1 - 6 (Model A and Model B
include both design types illustrated).

1 - 4 System Map



Feature

Model A

Model B

Designs

Design | & 11

Design | & Il

CPU
Types

Mobile Intel Pentium 4-M
Mobile Intel Celeron

Intel Pentium M

Wireless
LAN

Gemtek 802.11b Module with USB
Interface (optional)

Intel PRO Wireless LAN 2100
(802.11b) Wireless LAN Module with
PCI Interface

Post
Screen
Examples

Insyde Software MobilePro BIOS Version 1.01
Copyright 1983 - 2002 Insyde Software Corp. All

1600MHz Pentium 4-M with MMX CPU
icrocode Update Rev 01lh Cop

L2 Cache: =rred

8MB Video RAM

Insyde Software MobilePro BIOS Version 1.01
Copyright 1983 - 2002 Insyde Software Corp. All

2000MHz Celeron with MMX CPU

2 Cache - 256K Installed
Po~aicrocode Update Rev 01lh_Comy
L2 Cache: STTTTEY

Insyde Software MobilePro BIOS Version 1.01
Copyright 1983 - 2002 Insyde Software Corp. All

1400MHz Pentium M with MMX CPU
Microcode Update Rev 01lh Cop
L2 Cache: =rred
8MB Video RAM

Introduction

Table I - 1
Model Differences

4

Wireless LAN
Modules

If your computer is
Model A the Gemtek
USB Wireless LAN
module is an optional
item, depending on
your purchase choice.

If your computer is
Model B the Intel PRO
Wireless LAN 2100
PCIl module is included
as a standard item.

SystemMap 1 - 5
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Getting to Know Your Computer

7&( The following graphics will help you to become familiar with the basic func-

o tions, and to learn the location of the various ports and components of your

Design Differences
computer.

This manual refers to
the two notebook de-
signs pictured on this
page.

The designs vary
slightly in external de-
sign. Photographs

used throughout this
manual are of Design I.

In addition to the basic

designs, there are also

two colored (red and

blue) gloss style top

cover designs. See — =
for an illus- Design | Design Il

tration. Note the spe-

cific care instructions

for this type of cover.

e i ey

Figure I -1
Design Differences

1 - 6 System Map
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Gloss Style Top Cover Designs

There are two colored (red and blue) gloss style top cover designs incorporat-
ed within the design styles of this notebook model. Note the following guide-
lines for care and attention of this type of top cover.

* Remove the protective cover slowly and carefully. Do not forcibly tear
off the protective cover as this may damage the surface of the top cover.

» Do not use pointed objects on the surface of the top cover, and do not
place objects on top of it.

* Do not expose the top cover to excessive heat or direct sunlight.

* Only use the soft cloth provided for cleaning the top cover, and do not use
abrasive cleaners.

Figure I - 2
Gloss Style Top Cover

SystemMap 1 - 7
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Figure I - 3
Top View with LCD
Panel Closed

—_

LCD Latches
2. LED Power &
Communication
Indicators

1 - 8 Top View

Top View

To open the LCD display:

1. Place the computer on a stable surface.

2. Move the LCD latches @ in the direction of the arrows to release the top
cover (the left latch will lock in position and is clearly marked with locked -
and unlocked [ icons).

Lift the top cover to reveal the LCD panel and keyboard.

Adjust the LCD panel to a comfortable viewing angle.

The LED indicators Q show the power and battery status of the computer,
and give notification of e-mail received.

ok w
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Top View with LCD Panel Open
: D — Figure 1 -4

Top View with LCD
Panel Open

1. Optional Built-In PC

Camera

LCD

LED Power &

Communication

Indicators

Speakers

Close Cover Switch

LED Status

Indicators

Power Button

Keyboard

Built-In Microphone

0. TouchPad and
Buttons

11. Hot-Key Buttons

SEN

ook

S©eN

Top View 1 - 9
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PC Camera

If you have purchased the optional PC Camera, make sure you install the soft-
ware application (see “PC Camera” on page 7 - 15). The Module ON/OFF
Button will enable/disable the PC Camera (see “Module ON/OFF Button”
on page 1 - 13).

LCD Panel

The computer comes with a TFT (Thin Film Transistor), Liquid Crystal Dis-
play screen (see “LCD” on page A - 2 for details).

LED Power & Communication Indicators

These indicators display the system power status, and battery status of the
computer. The third indicator may be configured to give a visual confirmation
when e-mail is received in the default e-mail program (see “LED Power &
Communication Indicators” on page 2 - 6).

Stereo Speakers
Two built-in speakers provide rich, stereo sound.

1 - 10 Top View



Close Cover Switch

This switch acts as a sensor to tell when the LCD Panel is closed. When this
LCD cover sensor is activated the default setting of your operating system’s
power scheme sends the computer into a power saving state (see Figure 3 - 16
on page 3 - 27).

LED Status Indicators

These display the system’s operational status. Refer to “LED Status Indica-
tors” on page 2 - 5 for more information on what the lights mean.

Power Button

Press this button to turn your computer on or off (see “Turning on the
Computer” on page 2 - 4). This button may also be used as a suspend/resume
key, once configured as such in the power management control panel of your
operating system (see “Configuring the Power Button” on page 3 - 27).

4

Shutdown

Please note that you should always shut your computer down by choosing the Shut

Down/Turn Off Computer command from the Start menu in Windows. This will
help prevent hard disk or system problems.

Introduction a

S@DED

)
7

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination

doesn’t work, press the
power button for 4 sec-
onds, or longer, to
force the system to
turn itself off.

Top View 1 - 11
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LN

W M)

1 - 12 Top View

Keyboard

The computer has a “Win Key” keyboard including a numeric keypad. It has
the same features as a full-sized desktop keyboard and can easily be replaced
with a different language keyboard should you desire.

Microphone
Record on your notebook computer with the built-in microphone.

TouchPad & Buttons

The pointing device features a sensitive glide pad for precise movements. It
functions the same way as a two-button mouse. The right TouchPad button is
the same as the right mouse button; the left TouchPad button is the same as
the left mouse button. The central button may be used to scroll up and down,
or may be configured to perform a variety of functions (see “Configuring the
TouchPad and Buttons” on page 2 - 20).

Hot-Key Buttons

The three hot-keys allow you instant access to your default Internet browser
and default e-mail program, and to toggle on/off the modules (Wireless LAN/
Bluetooth/PC Camera modules). To learn how to set the buttons, see “Hot-
Key Buttons” on page 2 - 16.



Front View

Lo AT |

Hot-Key Buttons

The three hot-keys allow you instant access to your default Internet browser
and default e-mail program, and to toggle on/off the Wireless LAN/Bluetooth/
PC Camera modules. To learn how to set the buttons, see “Hot-Key Buttons”
on page 2 - 16.

Module ON/OFF Button

If your computer has the 802.11b Wireless LAN module (Model A computers
have the Gemtek USB module as an optional feature, Model B computers
have the Intel PRO Wireless LAN 2100 as a standard feature) and/or Blue-
tooth and/or PC Camera modules, you can use this button to turn the mod-
ules ON or OFF. To enable the modules you will need to install the drivers/
software for them (see “Gemtek USB Wireless LAN Module” on page 7 - 2,
“Intel PRO 2100 Mini PCI Wireless LAN Module” on page 7 - 5, “Blue-
tooth Module” on page 7 - 10 & “PC Camera” on page 7 - 15). Make sure
the wireless modules are OFF when you are using the computer aboard
aircraft (see sidebar).

Introduction a

Figure I -5
Front View

LCD Latches
Hot-Key Buttons

W M)

MANZ
1%

Wireless Device
Operation Aboard
Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the module(s) are
OFF if you are using
the computer aboard
aircraft. When your
computer ‘Boots Up’
the modules will be
ON.

. |
Front View 1 - 13
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Figure I -6
Left Side View

Vent

External Monitor
(VGA) Port
S-Video Out Port
RJ-11 Phone Jack
RJ-45 LAN Jack
2 *USB 2.0 Ports
Mini-IEEE 1394
Port

PC Card Slot

PC Card Eject
Button

]

1 - 14 Left Side View

Left Side View

Vent

This enables airflow to prevent the notebook from overheating.

2 N

Overheating

To prevent your computer from overheating make sure nothing blocks the vent/fan
outlet while the computer is in use.

External Monitor (VGA) Port

Connect an external VGA monitor to this port to allow dual video or simulta-
neous display on the LCD and external VGA monitor (see “Display Devices”
on page 3 - 9).
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S-Video-Out Port
Connect your television to your computer and view DVDs, VCDs or anything D
else your computer can display. You will need an S-Video cable to make the
connection. Enable this port from the video driver controls.

/
N

RJ-11 Phone Jack

This port connects to the built-in modem. You may plug the telephone line di-
rectly into this RJ-11 telephone connection.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

RJ-45 LAN Jack ﬁ

Left Side View 1 - 15
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.e » 2*USB 2.0 Ports

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for
low-speed peripherals such as keyboards, mice or scanners, and for high-
speed peripherals such as external HDDs, digital video cameras or high-speed
scanners etc. Devices can be plugged into the computer, and unplugged from
the computer, without the need to turn the system off (if the power rating of
your USB device is S00mA or above, make sure you use the power supply
which comes with the device). See Windows Service Pack information on
page 4 - 3.

Mini-IEEE 1394 Port

This allows high-speed connection to various peripheral devices, e.g. external
disk drives and digital cameras (see note below).

4

IEEE 1394

IEEE1394

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.

PC Card Slot

The 3.3V/5V slot may be used for a Type-II PC card (PC cards were also pre-
viously referred to as PCMCIA) and fully supports Cardbus. Refer to “PC
Card Slot” on page 2 - 15 for more information.

1 - 16 Left Side View
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nght Side View Figure 1 -7
Right Side View
1. Microphone-In Jack
2. Headphone-Out
@) (@ (@ - ‘ Jack
12223 / 3. S/PDIF Out Port
4. CD Device Bay
5. DC-In Jack
Microphone-In Jack A
Record on your notebook computer with an external microphone. y

Headphone-Out Jack

Headphones may be connected through this jack. Note: Set your system’s vol-
ume to a reduced level before connecting to this jack.

S/PDIF Out Port

This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to
connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1”
or ‘dts’ surround sound.

b

Right Side View 1 - 17
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CD Device Bay

A 5.25" CD-ROM drive, or DVD-ROM drive, or CD-RW, or Combination
CD-RW and DVD-ROM Drive (12.7mm height) is standard depending on the
model you purchased. For more information on using the drive please refer to
“CD/DVD Device” on page 2 - 11.

2 &

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interrup-
tion) you may push the end of a straightened paper clip into the emergency eject
hole. Do not use a sharpened pencil or similar object that may break and become

lodged in the hole.

DC-In Jack
Plug the supplied AC adapter into this jack to power your notebook.

|
1 - 18 Right Side View
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Figure I - 8
Rear View

Rear View

1. Security Lock Slot

2. Vent
Security Lock Slot £33
To prevent possible theft, a Kensington-type lock can be attached to this slot.
Locks can be purchased at any computer store.
Vent
This enables airflow to prevent the notebook from overheating.
7

Overheating

To prevent your com-
puter from overheating
make sure nothing
blocks the vent/fan
outlet while the com-
puter is in use.

. |
Rear View 1 - 19
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Figure I -9
Bottom View

Vent/Fan Outlets
Battery

CPU Cover

RAM & Bluetooth
Module Cover
CD Device Screw
Cover

Hard Disk &
WLAN Module
Cover

P
Overheating

To prevent your com-

puter from overheating
make sure nothing
blocks the vent/fan
outlet while the com-
puter is in use.

1 - 20 Bottom View

Bottom View

Vent

This enables airflow to prevent the notebook from overheating.

Battery

See “Battery Information” on page 3 - 28 for instructions on battery use and
care.

The CPU is not a user
serviceable part.
Opening this compart-
ment, or accessing the

CPU in any way, may
violate your warranty.




Hard Disk Drive

The internal hard disk drive is used to store your data. See page 6 - 4 for in-
formation on upgrading/replacing your hard disk drive.

2N\
/Ll\

Drive Warning

Don’t try to remove the hard disk (HDD) while the system is on. This could cause
data loss or damage. Unauthorized removal or tampering with the HDD may violate
your warranty. If you are in doubt, consult your service representative.

Wireless LAN (Network) & Bluetooth Modules

If your computer has the 802.11b Wireless LAN module (Model A computers
have the Gemtek USB module as an optional feature, Model B computers
have the Intel PRO Wireless LAN 2100 as a standard feature), and/or optional
Bluetooth module, the antenna and other components are not externally visi-
ble (please check with your service representative). If your configuration in-
cludes the module(s), make sure to install the driver (see “Wireless & PC
Camera Modules” on page 7 - 1 and sidebar note).

Introduction a

4

Wireless LAN &
Bluetooth Modules

The Wireless LAN and
Bluetooth modules

(and the optional PC
Camera module) may

be enabled and dis-
abled by pressing the
button at the front of
the computer (see
“Module ON/OFF
Button” on page 1 -
13).

Bottom View 1 - 21
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Using The Computer

Chapter 2: Using The Computer a

Overview

To learn more about using your computer, please read this chapter.
This chapter includes:

* The Power Sources

* Turning on the Computer

* The LED Indicators

* The Check Mail Program

* The Hard Disk Drive

* The CD/DVD Device

* The PC Card Slot

* The Hot-Keys

* The Function Keys & Numeric Keypad
* The TouchPad & Buttons/Mouse

» Adding a Printer (general guidelines)

. |
Overview 2 - 1
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n P The Power Sources

Power Button as

Standby or Hibernate AC Adapter

Button
Use only the AC adapter that comes with your computer. The wrong type of

1w alre Wz & Ul AC adapter will damage the computer and its components.
ACPIl-compliant OS,

(such as Windows o )
2000 Professional, or 1. Attach the AC adapter to the DC-in jack on the right of the computer.

The computer can be powered by either an AC adapter or a battery pack.

Windows XP) you can 2. Plug the AC power cord into an outlet, and then connect the AC power cord
use the OS’s “Power to the AC adapter.

Options” control panel 3. Raise the lid/LCD to a comfortable viewing angle.

to set the power button 4. Press the power button to turn “on”.

to send the system into
Standby or Hibernate
mode (see your OS’s
documentation, or
“Configuring the
Power Button” on
page 3 - 27 for de-
tails).

. |
2 - 2 The Power Sources



Battery

The battery allows you to use your notebook computer while you are on the
road or an electrical outlet is unavailable. Battery life varies depending on the
applications and the configuration you're using. To increase battery life, let the
battery discharge completely before recharging.

We recommend that you do not remove the battery. For more information on
the battery, please refer to “Battery Information” on page 3 - 28.

Recharging the Battery with the AC Adapter

The battery pack automatically recharges when the AC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it
will take several hours to fully recharge the battery. When the computer is
turned off but plugged into an electrical outlet, battery charge time is less. (Re-
fer to “LED Indicators” on page 2 - 5 for information on the battery charge
status, and to “Battery Information” on page 3 - 28 for more information on
how to maintain and properly recharge the battery pack.)

Proper handling of the Battery Pack

* DO NOT disassemble the battery pack under any circumstances
* DO NOT expose the battery to fire or high temperatures, it may explode
* DO NOT connect the metal terminals (+, -) to each other

The Power Sources 2 - 3
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Low Battery Warning

When the battery is
critically low, immedi-
ately connect the AC

adapter to the comput-
er or save your work,
otherwise, the un-
saved data will be lost
when the power is de-
pleted.
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Turning on the Computer

n Z " Now you are ready to begin using your computer. To turn it on simply press
Shutdown the power button on the front panel.
Note that you should
always shut your com- When the computer is on, you can use the power button as a Standby/Hiber-
puter down by choos- nate/Shutdown hot-key button when it is pressed for less than 4 seconds
ing the Shut Down/ (pressing and holding the power button for longer than this will shut the com-
puter down). Use Power Options in the Windows control panel to configure

Turn Off Computer
command from the ]
Start menu in Win- | this feature.
dows. This will help
prevent hard disk or
system problems.

4

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press
the power button for 4 seconds, or longer, to force the system to turn itself off.

.|
2 - 4 Turning on the Computer



LED Indicators

There are two sets of LED indicators (LED Power & Communication Indi-
cators and LED Status Indicators) on your computer that will display help-
ful information about the current status of the computer. The LED Power &
Communication Indicators are also visible when the top of your computer
is closed.

[ — 1]
Sem =@
ik (e =D
Power & Communication Indicators LED Status Indicators
LED Status Indicators
Icon Color Description
% Green Hard Disk/CD Device activity
(((I))) Green The Module(s) (WLAN, PC Camera, Bluetooth) is/are On
El Green Number Lock is activated
Green Caps Lock is activated
[El Green Scroll Lock is activated (to activate press Fn & ScrLk)

Using The Computer

Figure 2 - 1
LED Indicators

Table 2 - 1
LED Status
Indicators

4

Scroll Lock

To enable and disable
the Scroll Lock feature,
press the Fn and
ScrLk keys simultane-
ously.

LED Indicators 2 - 5
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B LED Power & Communication Indicators
Table 2 - 2
LED Power & Icon Color Description
Communication Orange DC power is plugged in
Indicators D/(I) Green The computer is on
Blinking Green The computer is in standby mode
Orange The battery is being charged

Green The battery is fully charged

Blinking Orange The battery has reached critically low power status

|
E Blinking Green New mail has arrived

2 - 6 LED Indicators
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Check Mail Program

After you have installed the driver for the Check Mail program (see “What
to Install” on page 4 - 2) you may then configure it to give notification
when new mail is received. You must be online to receive this notification
(note that this program only supports the POP3 protocol), and your default
mail program does not need to be open.

If you have installed the driver using the default settings, the CheckMail
program appears in the Startup menu (Start > Programs/All Programs
> Startup > CheckMail).

’f?j?g Activate Windows

Figure 2 - 2
Check Mail Program
(Startup Menu)

E2 Windows Catalog

% Windows Update

» |8 ms Explorer
) Outlook Express
. Remote Assistance
BT Run. & windows Media Player

& windows Messenger
] Log OFF Administrator...

iol Turn OFf Computer...

Clicking on Check Mail will bring up the following options menu.

Check Mail Program 2 - 7
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d

Note

Check with your Inter-
net Service Provider,

network administrator
or Mail Service provid-
er for details on what to
put on these pages.

Figure 2 - 3
Check Mail
Account Setup
and Options

5 Mail Check X

Mail Server |'1’our M ail Server Marne

|Jzer Hame: |Y0ur Usger Mame

Passward - | xxxxxxxxxxxx 1

SAVE | Connect ‘

Enable Check Mail .
O T 5 +| SecCheck Mal | 5% Mal'Wave
| | Hide

You may then configure the options for your mail server, user name, and
password. Click Enable Check Mail to have the program check the mail
server for new mail, and set the interval (in seconds). Click SAVE to keep
the settings, and Hide to minimize the program. After clicking Hide, the
program will be accessible by double-clicking the icon jlid in the taskbar. If
you click the close icon [ in the Check Mail control panel you will need
to run the program again from the Start menu in Windows, then access it
by double-clicking the taskbar icon.

2 - 8 Check Mail Program
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¥ Mail Check 3]

Figure 2 - 4
: Check Mail Enabled
Mail Server : ’—

User Name:
Password
SAVE Connect

Enable Check Mail
v |5 ~ | Sec Check Mai Q

Hide:

You may also enable an audible warning for received mail by clicking on
Set Mail Wave, and browsing to a .WAYV sound file to use for mail notifi-
cation. Click Enable play wave for mail arrival, and SAVE to save the
settings.

- T & Figure 2 - 5
— Set Mail Wave

Play wave path

A ‘C;\Prugram Files\ClevoMailCheck

Preview wave file

[ Enable play wave for mail arrival SAVE

Check Mail Program 2 - 9
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Power Safety

Before attempting to
access any of the inter-
nal components of
your notebook please
ensure that the ma-
chine is not connected
to the AC power, and
that the machine is
turned off. Also ensure
that all peripheral ca-
bles, including phone
lines, are disconnected
from the computer.

Figure 2 - 6
Hard Disk Location

2 - 10 Hard Disk Drive

Hard Disk Drive

The hard disk drive is used to store your data in the notebook computer. The
hard disk can be taken out to accommodate other 2.5" IDE hard disk drives
with a height of 9.5 mm.

The hard disk @ is accessible from the bottom of your computer as seen be-
low. Further details on removing and inserting the hard disk are available in
“Upgrading the Hard Disk Drive” on page 6 - 4.

Hard Disk




CD/DVD Device

There is a bay for either a CD-ROM, or DVD-ROM, or CD-RW, or Combi-
nation CD-RW and DVD-ROM drive, depending on the model you pur-
chased. The CD Device is usually labeled “Drive D:” and may be used as a
boot device if properly set in the BIOS (“Startup Menu” on page 5 - 9).

Loading Discs

To insert a CD/DVD, press the open button @) and carefully place a CD/DVD
onto the disc tray with label-side facing up (use just enough force for the disc
to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock
“clicks” and you are ready to start. The busy indicator @ will light up while
data is being accessed, or while an audio/video CD, or DVD, is playing. If
power is unexpectedly interrupted, insert an object such as a straightened pa-
per clip into the emergency eject hole @ to open the tray.

Using The Computer
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Sound Volume
Adjustment

How high the sound
volume can be set de-
pends on the setting of
the volume control
within Windows. Click
the Speaker icon on
the taskbar to check
the setting.

All peripherals must be
connected before you
turn on the system.

Figure 2 -7
CD Device

CD/DVD Device 2 - 11
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-y Handling CDs or DVDs

7&( Proper handling of your CDs/DVDs will prevent them from being damaged.
Please follow the advice below to make sure that the data stored on your CD-
ROMs/DVD-ROMs can be accessed.

CD Emergency Eject

If you need to manually

eject a CD (e.g. due to Remember to:

an unexpected power

interruption) you may * Hold the CD or DVD by the edges; do not touch the surface of the disc.

push the end of a + Use a clean, soft, dry cloth to remove dust or fingerprints.
SEEEEREEERE  « Do not write on the surface with a pen.

into the emergency . .

eject hole. However * Do not attach paper or other materials to the surface of the disc.

please do NOT use a * Do not store or place the CD or DVD in high-temperature areas.
sharpened pencil or * Do not use benzene, thinner, or other cleaners to clean the CD or DVD.

similar object that may * Do not bend the CD or DVD.

break and become .
rlazal T 72 e, * Do not drop or subject the CD or DVD to shock.

2 - 12 CD/DVD Device
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DVD Regional Codes

DVD region detection is device dependent, not OS-dependent. You can select
your module’s region code 5 times. The fifth selection is permanent. This can-

not be altered even if you change your operating system or you use the module
in another computer.

Figure 2 - 8
| General | Properties | WD Region | Yaolumes Diiver DVD Regional COdes
Mozt DWD s are encoded for play in specific regions. To play a (Wl ndows XP)

regionalized DVD on your computer, you must zet your OVD drive to
play discs from that region by zelecting a geographic area from the
fallowing list.

CAUTION “You can change the region a limited number of times.
After Changes remaining reaches zero, you cannat change the region even
if wou reinstall Windows or mowe your DVD drive to a different computer.

Changes remaining:

To change the curent region, select a geographic area, and then click QK.

| Urited KinEdom A
| Uraguay

| Uzbekistan

| Wanuatu

| Watican City

|Wenezuela ~

Current Region:  [Mat Selected
Mew Region: Fiegion 1

[ Ok ] [ Cancel
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Changing DVD Regional Codes

b Go to the Control Panel in WindowsXP/Windows 2000 and double-click Sys-
tem > Hardware (tab), click Device Manager, then click the + next to DVD/
CD-ROM drives. Double-click on the DVD-ROM device to bring up the
Properties menu, and select the DVD Region (tab) to bring up the control
panel as seen in “DVD Regional Codes (Windows XP)” on page 2 - 13.

Table 2 - 3
DVD Regional Coding DVD Regional Coding
Region Geographical Location
1 USA, Canada
2 Western Europe, Japan, South Africa, Middle East & Egypt
3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong
Kong

4 South & Central America, Mexico, Australia, New Zealand
5 N Korea, Russia, Eastern Europe, India & Most of Africa
6 China

. |
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PC Card Slot d

The computer is equipped with a PCMCIA 3.3V/5V slot for one type I1 PC
Card. Make sure you install the driver for the PC Card (see “What to Install”
on page 4 - 2).

Inserting and Removing PC Cards

» Align the PC Card with the slot and push it in until it locks into place.

+ To remove a PC Card, simply press the eject button @) next to the slot.
Figure 2 - 9
PC Card Slot

. |
PC Card Slot 2 - 15
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Table 2 - 4
Hot-Keys

2 - 16 Hot-Key Buttons

Hot-Key Buttons

These keys access the Internet and e-mail, and to enable/disable the module(s)
(WLAN/Bluetooth/PC Camera) with one quick button press. Make sure you
install the Hot-Key driver. Refer to “What to Install” on page 4 - 2 for driver
installation steps.

My Computer Hot-Key
The Hot-Key £ at the bottom left of the keyboard gives you quick one button
access to the My Computer folder on your computer.

Programming the Hot-Keys

Hot-Key Function
(@ Activate the default Internet browser
E] Activate the default e-mail program
((‘i’)) Toggle power to the module(s) - (Wireless LAN/Bluetooth/PC Camera
modules)




Function Keys and Numeric Keypad

Function Keys

On the bottom-left of the keyboard is the Fn key or Function key. The Fn key
allows you to change operational features instantly. To use the functions press
and hold the Fn key, then press the appropriate function key (F5 - F12 etc.)

located on your keyboard.

Keys Description
Fn Function Key
Fn + Esc Sleep/Resume Toggle
Fn+F5 Mute Toggle
Fn + F6 Display Toggle (if TV is.usec’i, as a display device see “Display
Devices” on page 3 - 9)
Fn+ F9 Decrease LCD Brightness
Fn+ F10 Increase LCD Brightness
Fn+F11 Decrease Audio Volume
Fn+ F12 Increase Audio Volume
Fn + Scr Lk Scroll Lock Toggle
Fn + Num Lock Toggles Padlock Mode (if set in the SCU “Enable Padlock
(Components Menu)” on page 5 - 15) if Number Lock is enabled

Function Keys and Numeric Keypad 2 - 17
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Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/hot
keys unique to the sys-
tem’s regular keyboard
may not work.

Table 2 - 5
Function Keys
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e

Special Characters

Some software appli-
cations allow the
number-keys to be
used with Alt to pro-
duce special charac-
ters. These special
characters can only be
produced by using the
numeric keypad. Reg-
ular number keys (in
the upper row of the
keyboard) will not
work. Make sure that
Num Lock is on.

Figure 2 - 10
Keyboard

Numeric Keypad

The keyboard has an embedded numerical keypad for easy numeric data input.
The numeric keys are highlighted by a yellow typeface.

Activate the Number Lock feature by pressing the Num Lock key at the top
right of the keyboard. You may check if Number Lock is enabled or not by
looking at the LED status indicators (see “LED Indicators” on page 2 - 5).
To type a number from the numeric keypad make sure Num Lock is enabled,
then hold the Fn key down and press the key on the numeric keypad (for in-
structions on Padlock mode see “Enable Padlock (Components Menu)” on
page 5 - 15).

Activate Scroll Lock by pressing and holding the Fn key, and then press the

Scr LK key at the top right of the keyboard.
Function Keys A F& 7 Fa Fo m‘ g

caaco

|

Prt Sc Delete Patse |

SysAq | (o ( | (Break
e o s
8 ) 0
Numeric Keypad Num Lock & |
Scr Lk Keys

(0

\' Backsr o8
& o
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TouchPad and Buttons/Mouse d

The TouchPad is a device for pointing (controlling input positioning) on the /
computer’s display screen by sensing finger movement, and downward pres- Mouse Driver
sure. It is an alternative to the mouse; however, you can also add a mouse to

If i -
your computer through one of the USB ports. i A

ternal mouse your op-
erating system may be
The TouchPad buttons function in much the same way as a two-button mouse. able to auto-configure

The central button may be configured to function as you require (see Figure your mouse during its

2 - 11 on page 2-20 for screen examples). g]zt?glsagggigrfz:ziiﬁ'

Be sure to check the
device’'s user docu-
mentation for details.

TouchPad and Buttons/Mouse 2 - 19
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Configuring the TouchPad and Buttons

Once you have installed the TouchPad drivers (see “What to Install” on
page 4 - 2) you can configure the functions by double-clicking the TouchPad
driver icon B¥ on the taskbar. You may then configure the TouchPad tap-
ping, buttons, scrolling, pointer motion and sensitivity options to your prefer-
ences. You will find further information on this at www.synaptics.com.

Mouse Properties 2|4 Mouse Properties @@
Flgu”'e 2 - ]] Bttoms{-Poiters|-Fonterptior—Harge| ) Device Setlings |
Mouse Properties BUltcn Eofigurtion 5 ynaptics Pointing Device Propetties - Version 7.2.5 06Dec02
iy andkeeo Desioes:
Select this check box to make the button on the

Enabled | Mame Port |
tight the ane you Lse for primary functions such i S naptics TouchPad V5.6 F5/2

at selecting and dragaing,

Double-click speed

Dauble-click the folder to test your setting. I the
folder does not open or close, by using a slower T Dizable Settings...
selting

Speed Slow e & Lzt

" Remave tiay icon from taskbar 4:20 PM
ClickLock
[ Tum on ClickLock = " Stalic lray icon in taskbar £ %20PM
Enables you to highlight or drag without holding down the mouse " Animated tray icon in taskbar ! 4:20 PM

button. To set, briefly press the mouse button. To release, click the
mause buttan again

W, SUNSPHCE, com

s
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Adding a Printer

The most commonly used peripheral is a printer. The following conventions
will help you to add a printer, however it is always best to refer to the printer
manual for specific instructions and configuration options.

USB Printer

Most new printers have a USB interface connection. You may use either of the
USB ports on your computer to connect the printer.

Install Instructions:

1. Set up the printer according to its instructions (unpacking, paper tray, toner/
ink cartridge etc.).

Turn ON the computer.

Turn ON the printer.

Connect the printer’'s USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask
you to supply one. Follow the on-screen instructions.

ok
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Parallel Printer
This is still the most common type of printer. A Parallel to USB converter
may be purchased at most computer stores.

Install Instructions:

1. Set up the printer according to its instructions (unpacking, paper tray, toner/
ink cartridge etc.).

Attach the parallel cable to the printer.

Connect the printer’s parallel cable to the Parallel to USB converter, and
then plug the converter into the USB port.

4. Turn ON the printer.

Turn ON the computer.

Windows (some operating systems may require a driver to recognize the
parallel to USB adapter) will identify the printer and either load one of its
own drivers or ask you to supply one. Follow the on-screen instructions.

@ N

o o
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Advanced Controls

Chapter 3: Advanced Controls
Overvi
verview >

This chapter covers:

e Advanced video controls Drivers

* Power and battery management features You are unable to use
most advanced con-
trols until the neces-
sary drivers and
utilities are properly in-
stalled. If your system
hasn’t been properly
configured (your ser-
vice representative
may have already
done that for you), re-
fer to “What to In-
stall” on page 4 - 2 for
installation instruc-

. . . . . tions.
Note: All operating system pictures in this manual are from the Microsoft

Windows XP OS.

Overview 3 - 1
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Advanced Video Controls

’ﬂ‘ This section is about making adjustments for the LCD, and switching display
Protecting the LCD devices.

Do not allow any for- Opening the LCD

eign objects (i.e. paper
or plastic) to get be- As you open the lid, adjust it so you can look at the screen straight on, without
S EREIEEEEUERE  any glare. If necessary, adjust the brightness controls (Fn + F9/F10).

the work panel. They
could damage or
scratch the LCD and/or
accidentally activate
the close cover switch.

Num Prt Sc Delete

L | e F7 Fa F9 F10 F11 F12
® eATico n alpy (53 Lock SysRg Ser Lk
6 7 0 - =
B Y G @ B =

{
[

T

Tab ™5

Figure 3 - 1 Lok
Brightness "
Controls ”

3 - 2 Advanced Video Controls



Video Memory

The computer does not have dedicated video memory. The video memory
available on your computer is configured in two modes of operation.

VGA Shared Memory

This is the pre-allocated memory size for VGA compatibility. This is fixed
in the BIOS at 32MB (see page 5 - 12). This memory is allocated from your
system memory e.g. if you computer has 128MB of memory (RAM), then
32MB will be allocated to video leaving the system with 96MB of RAM.

Dynamic Video Memory Technology

Intel® DVMT automatically and dynamically allocates as much (up to
64MB) system memory (RAM) as needed to the video system (the video
driver must be installed - see “What to Install” on page 4 - 2). DVMT
returns whatever memory is no longer needed to the operating system.

System Memory Maximum Memory Allocated for Graphics by DVMT
OMB - 127MB Not Supported
128 MB - 256MB 32MB

256MB - Maximum Memory | 64MB

Advanced Controls
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DVMT Notes

DVMT is not user-con-
figurable.

DVMT is not local vid-
€0 memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory in-
dicated.

*Note: The video driv-
ers for Windows 2000
require Service Pack 1
or later to run correctly.
Check with the Mi-
crosoft Windows 2000
support site for the lat-
est updates.

Table 3 - 1
DVMT Memory
Requirements

Video Memory 3 - 3
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Screen Resolution/
Screen Area Note

You may set the reso-
lution to a higher set-
ting than the panel
supports, however this
will require you to pan
(scroll) around the
screen as the display
area will be larger than
what you can see on
the LCD.

Video Driver Controls

The video interface lets you change the screen resolution and color output to
whatever is most comfortable/efficient for you. This is a matter of hardware,
video memory and the driver for your operating system. The driver interface
shows the available options (see “LCD” on page A - 2 for the LCD options).

You can switch display devices from the Display Properties control panel in
Windows as long as the video driver is installed (see “What to Install” on
page 4 - 2).

Making Adjustments for the Display

The higher the resolution you set the LCD for, the more information the LCD
can display on screen. To change the LCD’s resolution and color depth go to
the Display Properties control panel:

1. Click Start, point to Settings (or just click Control Panel) and click Control
Panel (if you are in Category View choose Appearance and Themes).

2. Double-click Display (icon).

3. Inthe Display Properties dialog box, click Settings (tab).

4. In Screen areal/Screen resolution, move the slider to the preferred setting
for resolution (see @) in Figure 3 - 2 on page 3-5).

5. In Colors/Color quality, click the arrow and scroll to the preferred setting
for color depth (see @ in Figure 3 - 2 on page 3-5).

3 - 4 Video Driver Controls



Display Properties

Display Properties

| Themes | Desktop | Scieen Saver | Appeaiance | Settings

Display:

Dirag the monitor icons to match the physical arangement of wour monitors,

| 1. Digital Flat Parnel [1024:768] on Intel[R) 82852/82055 GM/GME Gr v |

Screen resolution LColor quality

Less 0_3 Mare [ Medium (15 bt

Hze thiz device as the pimar:

Estend my \windows desklop e monikor

1024 by 768 pinels I'Im ' m.

[ Identify ][Iroubleshoot... ] [ Adgancedg

[_ ok ][ Cancel ]

(button) to bring up the options tabs. Clicking through these tabs allows you

to make any video adjustments you require.

Advanced Controls

Figure 3 -2
Display Properties

4

Intel(R) Extreme
Graphics Controller
Properties

You can click Graph-
ics Properties (but-

ton) in the Intel(R)
Extreme Graphics tab
(in the Advanced op-
tions) to access the

When the Display Properties control panel is open, click the Advanced @ screens in Figure 3 - 4

on page 3-7.

Video Driver Controls 3 - 5
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Intel Video Driver Controls

/ . After installing the video driver there will be an additional control panel en-
Taskbar titled Intel(R) Extreme Graphics. To get to the control panel to make chang-

You may also access
the control panel from 1.
the taskbar at the bot-

tom right of the screen. 2.
Click on the icon to
bring up the menu and
scroll to Graphics Op-
tions > Graphics
Properties.

Figure 3 - 3
Intel Extreme
Graphics Control
Panel

es to the Graphics Properties, do the following:

Click Start, point to Settings (or just click Control Panel) and click Control
Panel.

Double-click Intel(R) Extreme Graphics (icon) to bring up the Intel(R)
82852/82855 Graphics Controller Properties.

| output To »
Panel Fit 3
Hot Keys »
»

Inkel(R) Extreme Graphics
4 % ] 340PM

You may make changes to the Devices, Color, Schemes, Hot Keys by clicking
the appropriate tab and adjusting the setting, then clicking OK. The Informa-

tion and Open GL tabs display useful information about the graphics proper-

ties

of your computer, and the Support item in the Information tab has

weblinks to the latest information (drivers, troubleshooting issues etc.) on the
Intel Website. Some screen examples are shown on the following page.

3 - 6 Video Driver Controls



Intel(R) B2852/82855 GM/GME Graphics Controller Prope..

Deviees | Color | Schemes | Hot keys| Open6L | Infometon |

Seings

Colars High Color =
1024 by 768 )

Sereen Area

¥ Full Scrsen (No Border)

[3 Cancel

Intel(R) B2852/82855 GM/GME Graphics Controller Prope. Intel(R) B2852/82855 GMIGME Graphics Controller Prope.

Devicss Color | Schemes | HotKes | DpenGL | Information |

Gamma Ramp

Gama Conecion Colr
Garma —0 ||Fa
Biighiness: —+——0 || R
Contrast —r——— 8 || Gen
© Ble
Save Scheme. uis |
i3 Concel | 4o

Devicss | Color  Schemes | Hot Keys | OpertiL | Information |

Scheres Video Modes

<Curent Mode>
540 by 480 High Color (50 Hz)
640 by 480 True Color (60 Hz)
0 b 600 High Color (50 Hz)
80 by 600 True Color (60 Hz)

Output Device Color Adstments

" Cunent Device Fed  Gien  Bhe
€ Notebook

Noebock Gamma w1 10

Bightness o 0 0

Contst ET T

Application To Launch

& = 1 = |

Cancel p

Intel(R) B2852/B2855 GM/GME Graphics Controller Prope... [

Devices | Colr | Schemes  Hot Keys | opendL | Infomation |

W Enable Hot Keyd

Action [ Hot Key Combination
Enatle Notebaok <CTRL<ALT>F3
Enable/Disable Panel Fittiig  <CTRL><ALT>F11
Invoke Graphics Properties  <CTRL> <ALTSF12

[t ]
Cancel i

Intel{R) B2852/82855 GMIGME Graphics Cantroller Prope... [2)[X]

Devices | Color | Schemes | HotKeys OpenGL | informaton |

Selings
penG L ®
Attrbute [velue
Asynchronous Flip off
Triple Buffering Defaut
Flgping Polc Pl
Depth Buffer Bit Depth Defauit
Force S31C Texture Compression. OfF
Force FXTI texture compression  OFF
Driver Memory Fooy hormal
Texture Color Depth Desktop Color Depth
Anisotropic Fitering Application Control

Prior o contacting techrical suppart, please refer ta
the folloving self help resources:

Top Techrical Issues
it/ /suppotintel comsupport/raphics!.
Troubleshooting Assistart
hitp://supportintel comsupport/aoof/ kb bim
Graphics Diiver Downloads

hitp://supportintel com/support/o/dowrloads

18 you are unable to find an ansvier =t the resources
abave!

Graphics Driver Email Support

hitp.//supportintel com/support/go/afy/embim

Cancel p

Cancel p
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Figure 3 -4
Intel Graphics
Controller Properties
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Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut.
To find the application
right-click its shortcut
on the desktop click
Properties. Click the
Shortcut (tab) and see
where the executable
file is located by click-
ing the Find Target
(button). Note the loca-
tion and you will then
be able to browse to
this file.

Schemes

Use Schemes to configure quick settings for applications which require spe-
cific resolution and color settings in order to run properly e.g. games, multi-
media programs. To set the schemes:

1.

Go to the Intel(R) Extreme Graphics control panel (see “Intel Video
Driver Controls” on page 3 - 6).

Click on Schemes (tab).

Select New to setup the scheme, and type a name in the dialog box that
pops up, then click OK.

Click on the scheme name you had typed in the Schemes box, and choose
the option you wish to use from the Video Modes box.

Browse to the executable file for the application you want to set a scheme
for (see sidebar).

You can click in the "Reset On Exit" box to return to your original settings
when you exit the program, then click Save to save the settings.

When you want to run the program, select it from the Schemes box and
click "Invoke" to run the highlighted program in the chosen video setting
(alternatively you can select it from Display Modes by clicking on the icon
option in the taskbar at the bottom right of the screen).

3 - 8 Video Driver Controls



Display Devices

Besides the built-in LCD, you can also use an external VGA monitor or TV
as your display device. A VGA monitor connects to the external monitor
(VGA) port @), a TV to the S-Video Out port @ (Figure 3 - 5).

o @

Switching/Enabling Displays (Keyboard)

You can switch display devices with the Fn + Display (F6) toggle. With the
video driver installed, you also can use its built-in controls to switch the dis-
play options. If you haven’t installed the video driver, refer to (see “What to
Install” on page 4 - 2) for setup instructions. To switch the display options:

1. Plug the VGA monitor or TV into the appropriate port.

2. Press and hold the Fn key, while simultaneously pressing the F6 key.
Note: If you are using a TV use the hot key combinations Ctrl + Alt + F1 (VGA
monitor only), Ctrl + Alt + F2 (TV only) and Ctrl + Alt + F3 (notebook LCD
only), not Fn + F6.

3. You may toggle through the options to display the notebook’s LCD only, the

external display alone and the LCD and the external display together (make
sure you allow time for the screens to refresh as you toggle through).

Advanced Controls

Figure 3 -5
Left Side View

4

Using the Driver to
Switch Displays

If you only use the key-
board toggle to switch
through the display op-
tions you will not have
all the configuration
options available to
you. If you want to ac-
cess the options listed
in “Display Devices”
on page 3 - 9 use the
driver control panel to
configure the settings
as per “Switching/En-
abling Displays (Driv-
er)” on page 3 - 10.

.|
Display Devices 3 - 9
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Figure 3 -6

Switching Display
Settings

Vertical Refresh Rate

The vertical refresh rate
of your monitor is impor-
tant. If it is too low and/or
you're using fluorescent
lighting, the screen will
appear to flicker. To re-
duce flickering on a moni-

tor, use faster refresh
rates (we recommend a
refresh rate of 72Hz or
more). But first check
your monitor's documen-
tation to make sure it can
support the rates listed by
the video driver. The de-
fault refresh rate for mon-
itors (without drivers) is
60Hz.

3 - 10 Display Devices

Switching/Enabling Displays (Driver)
With the video driver installed (see “What to Install” on page 4 - 2), you can
use its built-in controls to switch between the displays as follows:

Plug the VGA monitor or TV into the appropriate port.
Go to the Intel(R) 82852/82855 Graphics Controller Properties control
panel (see “Intel Video Driver Controls” on page 3 - 6) and select

Devices (tab).

Choose the display option from the list on the left and click Apply (and OK

to confirm the settings change).

You can choose a device to be Primary or Secondary.

Intel(R) B2B52/82B55 GMIGME Graphics Controller Prope... [2][5]

Deviess | Color | Schemes | Hot Keps | OpenGL | Infarmion |
Davices

Primay Device Meritor =
Secondaty Device [Wotsbook =]

Device Options

I~ Same displey confiquration diven on both displays

Device: 5 ettings.

[ Cancel J Apply J

Confirm Desktop Change

“r'our desktop hag been reconfigured. Do you want to keep
these settings?

If ho rezponze is received within 15 seconds these changes
will automatically be cancelad.

Ok | Cancel

See the following pages for instructions on enabling Clone and Extended
Desktop modes.
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Multi-Monitor Modes

In addition to the single LCD display mode you have the following Multi-
Monitor modes available when the external monitor or TV is attached.

Intel(R) Dual Display Clone

This mode will drive multiple displays with the same content. Use this feature
to display the screen through a projector for a presentation.

Extended Desktop

This mode allows a desktop to span multiple displays and acts as a large work-
space. This creates a lot more screen area for display. Use the Display Prop-
erties control panel to drag the monitors to match the physical arrangement
you wish to use, or you may also use the Extended Desktop Settings control
panel tab in Intel(R) 82852/82855 Graphics Controller Properties to con-
figure the relative size and position.

Intel(R) Dual Display Multi

This mode will allow you to display the same content on two displays, and
have different content on a third display. This could be used to display a demo
on two displays, while taking notes on the third display.

.|
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Figure 3 -7
Device Settings
(Clone Mode)

3 - 12 Display Devices

To Enable Dual Display Clone Mode:

1.
2.

Plug the VGA monitor or TV into the appropriate port.

Go to the Intel(R) 82852/82855 Graphics Controller Properties control
panel (see “Intel Video Driver Controls” on page 3 - 6) and select
Devices (tab).

Click the Intel(R) Dual Display Clone icon in the devices tab (Note: this
option is only available when you have attached a monitor or TV).
Choose which device is to be the Primary display, and which is to be
Secondary.

Adjust the settings by clicking the Device Settings (button) if necessary.
Click Apply > OK and close the control panels.

Intel(R) B2B52/B2855 GM/GME Graphics Controller Prope... [2|[] | Device Settings
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Colors High Calar -
Primary Device Manitor e
Scieen drea [0z by 708 =
Seconday Device [Holebocke <] ReftsshPate SF =
Device Options

Hotebook [Secondary]
Settings

I~ Same display configuration driven on both displays y
~
P W Full Serzen (Mo Border]
Device Seltings
SN~ Cancel
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To Enable Extended Desktop Mode:

1. Plug the VGA monitor or TV into the appropriate port.

2. Go to the Intel(R) 82852/82855 Graphics Controller Properties control
panel (see “Intel Video Driver Controls” on page 3 - 6) and select
Devices (tab).

3. Click the Extended Desktop icon in the devices tab (Note: this option is
only available when you have attached a monitor or TV).

4. Choose which device is to be the Primary display, and which is to be
Secondary.

5. Adjust the settings by clicking the Device Settings (button) if necessary.

6. Click Apply > OK and close the control panels.

Intel(R) B2852/B285% GM/GME Graphics Controller Prope... [2]
n e ) raphics Controller Prope... [2 ) P e e R

Device: o | eys | OpenGL | Information |

Notebook [Primary) Mentor [Secondary)

Settings Settings

Colors: Tiise olor = Colars Tiue Color -

Soreen Area 1024 by 768 - Soreen Area

Refrech Rate

¥ Full Sereen [No Border]

)
" /‘ﬁ Cancel

You can also enable the Extended Desktop mode from the Display Properties
control panel (see “Display Properties” on page 3 - 5).

Advanced Controls
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Device Settings
Extended Desktop

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your

monitor can support
them.

You can drag the mon-
itor icons to match the
physical layout of your
displays. lcons and
programs may also be
dragged between the
displays.

Figure 3 - 8
Device Settings
(Extended Desktop
Mode)
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To Enable Extended Desktop (Display Properties)

/ 1. Plug the VGA monitor or TV into the appropriate port.
2. Click Start, point to Settings (or just click Control Panel) and click Control
Extended Desktop Panel (if you are in Category View choose Appearance and Themes).

Mode 3. Double-click Display (icon).

If Intel Dual Display 4. Inthe Display Properties dialog box, click Sgttings (tab). _
5. Make sure you have checked “Extend my Windows desktop onto this

ly enabled, you must monitor.” and click Apply.

use the Intel(R)

82852/82855 Graph-

ics Controller Prop-

erties to switch the

display.

Clone mode is current-

el Monitor o nfF] 2852/52655 GMGME Eraphics Cori |

Sereen iesobtion Color qualy
Lees v More [Highest (32 b v
1280 by 758 pirels I'm = =

ok ) (Cconeel J [ eony

Use the control panel to drag the monitors to match the physical arrangement
you wish to use. In the example shown in Figure 3 - 9 the primary monitor
is on the left, the secondary display is on the right. You can drag any icons or
windows across to either display desktop, which makes it possible to have one
program visible in one of the displays, and a different program visible in the
other display.

Figure 3 -9
Display Properties
(Extended Desktop

Mode)
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To Enable Dual Display Multi:

1.

2.

w

oo

Plug the VGA monitor and TV into the appropriate port (you will need to
have three display devices attached for this display mode).

Enable Extended Desktop Mode (see “To Enable Extended Desktop
Mode:” on page 3 - 13).

Click the Enable Twin Configuration checkbox.

Choose which device is to be the Primary display, and which is to be
Secondary (this will affect which devices can be the Source and
Destination).

Adjust the settings by clicking the Device Settings (button) if necessary.

Click Apply > OK and close the control panels.

Intel(R) 82852/82855 GM/GME Graphics Controller Prope... E|g\

Devices | Color | Schemes | Hot Keps | GpenGL | Information |
Estended Desktop Settings

Primary Device Notebook. bt
Secondary Device Television ¥

¥ Enable Twin Configuration
T Comor=t

Source

Destination onitor

5 Device Settings.

[ P | Apply |

Advanced Controls

Figure 3 - 10
Device Settings
(Dual Display Multi
Mode)
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TV System
If you are using a TV as a display device you may change the video standard
to NTSC or PAL as follows:

1. Plug the TV into the appropriate port.

2. Go to the Intel(R) 82852/82855 Graphics Controller Properties control
panel (see “Intel Video Driver Controls” on page 3 - 6) and select
Devices (tab).

3. Choose the display mode (Television, Clone or Extended Desktop) and
set the device to be Primary or Secondary if required.

4. Adjust the settings by clicking the Device Settings (button).
5. Choose the appropriate TV system from Video Standard dropbox.

Figure 3-11 Intel(R) B2B52/82855 GMIGME Graphics Controller Prape... [2|[X]
TV Video Standard Davices | Coke Wsmﬁes Hot Keys | OpenGL | Infomation |
Settings
Colors [TueCor =]
A [1o24bp788 |

Video Standard

I~ Full Scieen (o Border]

ER Cancel | eonty |

.|
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Power Management Features

To conserve power, especially when using the battery, your notebook comput-
er uses the ACPI power management system. Power management conserves
power by controlling individual components of the computer (the monitor and
hard disk drive) or the whole system.

Advanced Configuration and Power Interface

The ACPI interface provides the computer with enhanced power saving tech-
niques and gives the operating system (OS) direct control over the power and
thermal states of devices and processors. For example, it enables the OS to set

devices into low-power states based on user settings and information from ap-
plications. ACPI is fully supported in Windows 2000 and Windows XP.

.|
Power Management Features 3 - 17
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OS Note

Power management
functions  will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user’s manual of your
operating system.

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)



Advanced Controls

Enabling Power Options

Power Options are enabled through the control panel in your Windows sys-
tem (Power Options). With other operating systems you may have power
management available, so check your documentation.

Flgl/ll"e 3 - ]2 B Control Panel =]
L

Ele Edt View Favorites Iools Help

Power Options : _
Qo - @ - ¥ POsearct [rcoes | [l

Control Panel detess |G Control Panel
& %X D B P &

“h
E ontrol Panel
Admlnlstratlve Bluetooth  Date and Tme  Display

Accessibilty  AddHardware  Addor

(@ switch to Categary Yisw Cptions Remer.. ool Carfiguration

TEEEEXY

- Folder Options Fonts Game Intel(R; )
Controllers  Extre.. Options

N

rinters and  Regional and  Scanners and

v B

Internet Keyboard Madem
Settings

See Also

L Windows Update

@) Help and Support % e
DR

Maouse: Mletunork
Connections

igure energy-saving settings for your computer.
A ¥ o
B © ¥ U &

Scheduled  SoundEffect Soundsand  Speech System  Taskbarand User Accounts
T Manager Audio Devices Start Menu

V.92 ‘é

Y.92 features  Wirsless Link
settings

You may conserve power through individual components or throughout the

whole system.
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Power Schemes

You can set your computer to conserve power through individual components
by means of Power Schemes. You can also adjust the settings for each
scheme to set the monitor to turn off after a specified time, and the computer's
hard disk motor to turn off if the hard disk drive has not been accessed for a
specified period of time (if the system reads or writes data, the hard disk motor
will be turned back on). The schemes may also be set to set a specified time
for the system to enter Standby or Hibernate modes (see “Conserving Power
(System)” on page 3 - 25).

Power Options Properties

Pawer Schemes | Alams | Power Meter | Advanced | Hiberale

Select the power scheme with the most appropriate settings for
this computer. Note that changing the settings below will modify
the selected scheme.

%

Power schemes

| Portable/Laptop v/
Home/Office Desk

Presentation

Always On

Minimal Power Management
Mz B sttery

P compuien s Plaged @ TR
batteries

Tum off maritor |Aher1Sming v | |Afer 5 ming v

Tunoff had disks: | Aterd0mins v | |AfterGmins v

System standby: |Ater 20ming | | Afer 5 ming v

Spstem hibernates: | After 3 hours vI iAflethours ~|

Advanced Controls
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Resuming Operation

The system can re-
sume from Monitor or
Hard Disk Standby by
pressing a key on the
keyboard.

Figure 3 - 13
Power Schemes

Enabling Power Options 3 - 19




Advanced Controls

Power Schemes and Processor Performance

/ Each Windows Power Scheme will also adjust the processor performance of
Windows Control your machine in order to save power. This is worth bearing in mind if you are
Policies experiencing any reduced performance (especially under DC/battery power).
Windows defines four control policies (see sidebar) used with each power
Constant ~ CPU’s scheme
performance always )
runs at lowest level
Adaptive ~ CPU’s per- Power Scheme AC Power DC Power
formance will be ad-
justed as demanded Home/Office Desk None Adaptive
by the system Portable/Laptop Adaptive Adaptive
Degrade ~ CPU’s per-
Presentation Adaptive Degrade

formance starts at low-
est level aer reduces Always On None None
as battery discharges

None ~ CPU’s perfor- Minimal Power Management Adaptive Adaptive

mance always runs at Max Battery Adaptive Degrade
the highest available
performance state

Set the Power Scheme which is most appropriate for the conditions and the
applications you are using (e.g. games, 3D applications, audio and video pro-

Table 3 - 2 grams etc. usually require high CPU performance). See also Table 3 - 3 CPU
Power Scheme SpeedStep Control Settings’ on page 3-24 for further information on power
Control Policies saving settings and CPU performance.

.|
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Intel CPU SpeedStep Controls

Additional controls are available to support the Intel Pentium M (only sup-
ported in Model B computers) processor’s mobile power management fea-
tures. These controls may be adjusted in the Intel CPU SpeedStep settings in
the BIOS. See “BIOS Utilities” on page 5 - 1 for details on how to access the
BIOS utilities, and “CPU SpeedStep Controls (Power Menu)” on page 5-17
for the specific menu.

Windows 2000 and Windows XP with Service Pack 1 installed support the ba-
sic features of the Intel CPU SpeedStep controls. As long as you have Win-
dows XP with Service Pack 1 installed, you may download and install an
additional processor drivers (Q332179 & Q330512 QFE drivers) to support
additional features such as Intel Enhanced SpeedStep Technology and Intel
Deeper Alert Sleep State. The instructions on downloading the drivers are in
the sidebar. You can check if your current processor driver for Windows XP
(with Service Pack 1 installed) needs to be updated by following this proce-
dure:

Checking the Processor Driver Version

1. If you can see the My Computer icon on your desktop (if you cannot see
the My Computer icon go to step 2) click on it once to select it, then
right-click it to make the sub-menu appear and scroll down to Properties
and click on it (go to step 3).

Advanced Controls

4

Windows XP Service
Pack 1 Drivers to
Support Power
Management Features

The drivers that sup-
ports the mobile pro-
cessor power
management features
of Intel Pentium M Pro-
cessors will be in-
stalled if you
automatically update
your Windows XP ver-
sion (you must have
Service Pack 1 in-
stalled) from the Mi-
crosoft website.
Further information is
available if you search
the Microsoft website
for article Q332179
(enter the article num-
ber in the search box
and click Go).
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2. If you cannot see the My Computer icon click Start (menu), then point
to (don’t click just highlight it) My Computer. Right-click it to make the
sub-menu appear and scroll down to Properties and click on it (go to step

3 3).
. Click the Hardware (tab), then click Device Manager (button).
Click “+” next to Processors (if its sub-items are not shown).
. Double-click Intel(R) Pentium(R) M processor 1*00MHz and click
Driver (tab).
Click Driver Details (button).
. If the driver is the updated version, the suffix gv3.sys will appear in the
Driver files box, and you do not need to update it (see Figure 3 - 14).

Figure 3 - 14 Driver, File Details PIX Driver File Details PIX

Processor Driver
Version _
(WinXP SP1) —

RN

~N o

@ IntellR) Pertium(R) M processor 1300MHz ﬁ Intel(R] Pentium(R) M processor 1300MHz

Driver files:
= ECAWIN

Updated driver

Provider. Microsaft Corporation Provvider: Microgoft Corporation
If you do not see the suffix gv3.sys you will need to download and install the
drivers (see the instructions on page 3 - 27). When the drivers are downloaded,
follow the two part instructions on the following page to install and run the
drivers (you will need to Unzip the contents of the Zip file to a location on
your hard disk).

3 - 22 Intel CPU SpeedStep Controls



Installing the Driver

1.

9.

If you can see the My Computer icon on your desktop (if you cannot see
the My Computer icon go to step 2) click on it once to select it, then
right-click it to make the sub-menu appear and scroll down to Properties
and click on it (go to step 3).

. If you cannot see the My Computer icon click Start (menu), then point

to (but don’t click just highlight it) My Computer. Right-click it to make
the sub-menu appear and scroll down to Properties and click on it (go to
step 3).

. Click the Hardware (tab), then click Device Manager (button).
. Click “+” next to Processors (if its sub-items are not shown).
. Double-click Intel(R) Pentium(R) M processor 1*00MHz and click

Driver (tab).
Click Update Driver (button).

. When the Hardware Update Wizard appears, click “Install from a list or

specific location (Advanced)” then click Next.

. Select “Search for the best driver in these locations.” and select ONLY

“Include this location in the search:”.
Navigate (Browse...) to the GV3 Folder (the location where you have
unzipped the downloaded file) and click OK > Next.

10.Click Finish > Yes to restart your computer.
11.After the restart browse to the GV3 Folder (the location where you have

Intel CPU SpeedStep Controls 3 - 23

unzipped the downloaded file) and run the
Q330512 WXP_SP2 X86.EXE file.
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CPU Performance with
SpeedStep

The CPU SpeedStep
options will adjust the
speed of the CPU ac-
cording to the setting in
the BIOS, and in some
cases this will reduce
the CPU performance
in order to conserve
power  consumption
(generally  speaking
the higher the speed a
CPU runs, the more
power it will consume).
You will need to set the
CPU SpeedStep set-
tings (and the Win-
dows Power Scheme
settings) in order to
gain a balance be-
tween good perfor-
mance and power
saving.
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CPU SpeedStep
Control Settings

You can adjust the
SpeedStep control set-
tings from the BIOS
(see “CPU Speed-
Step Controls (Power
Menu)” on page 5 -
17). The default BIOS
setting is Automati-
cally Switch. However
even if the CPU set-
tings are at *Max
Speed/600MHz, the
CPU speed will still be
affected by the Win-
dows Power Scheme
setting (this may also
adjust the CPU
speed).

Table 3 - 3
CPU SpeedStep

Windows XP Service Pack 1

CPU Wlnfiows 2?00 or \{Vlndows XP NIthIEnhancodiPower
with Basic Service Pack 1 .
SpeedStep Management Drivers Installed
Control
Settin
s T CPU Speed T CPU Speed
Source Source
AC In CPU Max Speed || AC In 600MHz ~ Max
Speed
Performance
Mode Always Battery (not low) | CPU Max Speed || Battery (not low) Up to hﬂax
Speed
Low Battery 600MHz Low Battery Up to 600MHz*
AC In 600MHz AC In 600MHz
Battery
Optimized Battery (not low) | 600MHz Battery (notlow) | Up to 600MHz*
Always
Low Battery 600MHz Low Battery Up to 600MHz*

Automatically
Switch

AC In

Battery (not low)

Low Battery

CPU Max Speed

600MHz

600MHz

AC In

Battery (not low)

Low Battery

600MHz ~ Max
Speed*

Up to 600MHz*

Up to 600MHz*

Control Settings * The Speed is defined by the Power Scheme set in Windows (see Table 3 - 2 on page 3 - 20).
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Conserving Power (System)

With this function you can stop the notebook’s operation and restart where
you left off. This system features Standby and Hibernate sleep mode levels
(Hibernate mode will need to be enabled by clicking the option in the Hiber-
nate tab in the Power Options control panel - Figure 3 - 15 on page 3-26).

Hibernate Mode vs. Shutdown

Hibernate mode and Shutdown are the same in that the system is off and you
need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left
off (what was on your desktop) without reopening the application(s) and
file(s) you last used.

You can use either method depending on your needs.

Standby Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put the sys-
tem on standby instead of in hibernation. It takes a longer time to wake up the
system from Hibernate mode than from Standby mode.

Advanced Controls
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System Resume

The system can re-
sume from Standby
mode by:

* Pressing the power
button

* Pressing the key
combination Fn +
Esc

¢ An alarm resume
that is enabled and
expires

* An incoming call
received on the
modem

Figure 3-15
Enable Hibernation

Standby

Standby saves the least amount of power, but takes the shortest time to return
to full operation. During Standby the hard disk is turned off, and the CPU is
made to idle at its slowest speed. All open applications are retained in memo-
ry. When you are not using your computer for a certain length of time, which
you specify in the operating system, it will enter Standby mode to save power.

Hibernate

Hibernate uses no power and saves all of your information on a part of the
HDD before it turns the system off. Although it saves the most power it takes
the longest time to return to full operation. You can set your notebook to au-
tomatically enter Hibernate mode when the battery power is almost depleted.
You will need to enable Hibernate mode from the Hibernate tab in the Power
Options control panel. The system will resume from Hibernate mode by
pressing the power button.

Power Options Properties

Power Schemes | Alams | Power Meter | Advanced | Hibemats

e When vour computer hibernates, it stores whatever it has in
(] memory on your hard disk and then shuts down, When your
computer comes out of hibemation, it retums to its previous state.

Hibernate
[F1E nabie hibematioré

[Disk space for hiberatian
Free disk space: B.015 MB
Disk space required to hibemate: 248 ME
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Configuring the Power Button

The power button may be set to send the computer in to either Standby or Hi-
bernate mode (Figure 3 - 16). In Standby mode, the LED D-/(b will flash
green. In Hibernate mode the LED will be off. If you are in a power saving

mode set to save power through individual components (e.g. hard disk, mon-
itor), the LED will remain green.

Power Options Properties |EE| Power Options Properties |E|®

Power Schemes || dlams | Power Meter| Advanced | Hibemate Power Schemes | Alaims | Power Meter | Advanced | Hibemate
| ';‘" Select the power-saving settings you want to Lse ‘_2; ‘, Select the power-saving settings you want to use
Options Options
[ hways show icon on the taskhar [ &ways show icon on the taskbar
Prompt tor password when computer resumes fram standby Prompt for password when computer resumes from standby
Fower buttons Power buttons
‘when | close the lid of my portable computer: When | close the lid of my portable computer.
[Stand by v [ stand by ~|
“when | press the power button on my computer. When | press the power buttan on my computer:
Shut down v | Shut down v |
Do nothiry
Ak me wﬁal tada ‘When | press the sleep button on my computer:
Stand by =
Hiternate Sandby
S hut down Do nothing
Ak me what to do
Hibernate

Power Button Sleep/Resume(Sleep)Button

Advanced Controls
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Sleep Button

You may also config-
ure the Sleep/Resume
key combination (Fn +

Esc) from the menu il-
lustrated in Figure 3 -
16. In Windows this is
referred to as the
Sleep button.

Figure 3 - 16
Power Options
(Advanced - Power
Buttons)
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P
Caution

Danger of explosion if
battery is incorrectly
replaced.

Replace only with the
same or equivalent
type recommended by
the manufacturer. Dis-
card used battery ac-
cording to the
manufacturer’s in-
structions.

Battery Information

Please follow these simple guidelines to get the best use out of your battery.

New Battery

Always completely discharge, then fully charge, a new battery (and subse-
quently at least once every 30 days or after about 20 partial discharges) before
using it (see “Battery FAQ” on page 3 - 29 for instructions on how to do this).

Battery Life

Your notebook computer’s battery life is dependent upon many factors, in-
cluding the programs you are running, and peripheral devices attached. Power
Options settings in the OS will help prolong the battery life if configured ap-
propriately.

Battery life may be shortened through improper maintenance. To optimize the
life and improve its performance, fully discharge and recharge the battery at
least once every 30 days.

We recommend that you do not remove the battery yourself. Please consult
your service representative should you need to remove the battery for any rea-
son.
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Battery FAQ

How do I completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery.
Don’t turn off the computer by yourself even when you see a message that in-
dicates the battery is critically low, just let the computer use up all of the bat-
tery power and shut down on its own. Disable the Power Options functions
in the Control Panel, especially any Alarms (unclick the tickboxes) and
Schemes (change all the settings to Never). As the battery nears the end of its
life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light
changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or af-
ter about 20 partial discharges.

Conserving Battery Power

The LCD display consumes a lot of power, so lowering the brightness level
will save power. Different applications and external devices consume battery
power even when they are not being used (see the sidebar note for further
recommendations on battery conservation).

Battery Information 3 - 29
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Conserving Battery
Power

To conserve battery
power:

Close modem or com-
munication applica-
tions when they are not
being used.

Remove any unused
PC Cards from the
computer (PC Cards
quickly use up battery
power even if the sys-
tem enters sleep
mode).

Disconnect any unnec-
essary external devic-
es.
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Drivers & Utilities

Chapter 4: Drivers & Utilities

Overview

This chapter deals with installing the drivers and / q
utilities essential to the operation or improvement

of some of the computer’s subsystems. The system Assumption

takes advantage of some newer hardware compo- We assume that you will install all drivers and utilities

nents for which the latest versions of most available from the built-in CD device and it is assigned to “Drive

operating systems haven’t built in drivers and utili- D:”. In addition, all file extensions can be seen [see

ties. Thus, some of the system components won’t Navigate (Browse..) to D:” on page 4 - 2].

be auto-configured with an appropriate driver or
utility during operating system installation. Instead,
you need to manually install some system-required
drivers and utilities. In this chapter, we group driver
and utility installation instructions by operating
system. The following operating systems are cov-
ered.

*  Windows 2000 Professional
*  Windows XP Professional and Home Editions

. |
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Drivers & Utilities

What to Install

The Device Drivers & Utilities + User’s Manual
CD-ROM contains the drivers and utilities neces-
sary for the proper operation of the computer. (The
Intel Wireless LAN module driver, and the op-
tional Bluetooth module driver and PC Camera
driver are on the separate CD-ROMs supplied.)
Table 4 - 1 on page 4-6 lists what you need to in-
stall manually according to your choice of the oper-
ating system. It is very important that the drivers
are installed in the order indicated in the table.

Module Driver Installation

The procedures for installing drivers for the Wire-
less LAN, PC Camera and Bluetooth modules are
provided in “Wireless & PC Camera Modules” on
page 7 - 1. Make sure that the drivers are installed
in the order indicated in Table 4 - 1 on page 4-6. If
your purchase does not include any of the modules,
DO NOT install the drivers for them.

4

Navigate (Browse..) to D:

You will notice that many of the instructions for driver
installation require you to “Navigate (Browse) to D:".

In this case “D:” is the drive specified for your CD de-
vice. Not all computers are setup the same way, and
some computers have the CD listed under a different
drive letter - e.g. if you have two hard drives (or hard
disk partitions) one may be designated as “Drive C:”
and the other as “Drive D:”. In this case the CD device
may be designated as “Drive E:” - Please make sure
you are actually navigating to the correct drive letter
for the CD device.

When you click the Browse (button) after clicking
Run in the Start menu you will see the “Look in:” di-
alog box at the top of the Browse window. Click the
scroll button to navigate to My Computer to display
the devices and drive letters.
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Service Packs

Check the warnings on the following pages regard-
ing installation of the appropriate Service Pack for
your Windows OS. If you are unsure of the Service
Pack currently installed see below. Make sure you
have installed the appropriate Service Pack before
installing all the drivers.

d

Service Pack Installed

To see which Service Pack is currently installed on
your computer go to the General tab of the System

control panel. Right-click the My Computer icon on
the desktop or in the Start menu (in WinXP only) and
select Properties. The Service Pack currently in-
stalled on your system will be listed under the “Sys-
tem:” heading. (If no Service Pack information is
listed, then no Service Pack is installed.)

What to Install 4 - 3
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Windows 2000 Service Pack 4
Make sure you install Windows 2000 Service Pack
4 (or a version of Windows 2000 which includes

SP4) before installing any drivers. Service Pack 4
includes support for USB 2.0.

If you have upgraded the system by installing Ser-
vice Pack 4 (i.e. your Windows 2000 version does
not include Service Pack 4) then follow these in-

structions:

1.Go to Device Manager (see step 1 of the PC Card
driver installation instructions on page ) and
click “+” next to Other devices (if its sub-items are
not shown).

2.Right-click Universal Serial Bus (USB) control-
ler and click Uninstall > OK.

3.Restart the computer and it will find the USB 2.0
controller.
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Windows XP Service Pack 1

Make sure you install Windows XP Service Pack 1
(or a Windows XP version which includes Service
Pack 1) before installing any drivers. Service
Pack 1 includes support for USB 2.0.

If you have upgraded the system by installing Ser-
vice Pack 1 (i.e. your Windows XP version does not
include Service Pack 1) then follow these instruc-
tions:

1.Go to Device Manager (see step 1 of the PC Card
driver installation instructions on page ) and
click “+” next to Other devices (if its sub-items are
not shown).

2.Right-click Universal Serial Bus (USB) Control-
ler and select Uninstall > OK.

3.Restart the computer and it will find the USB 2.0
controller.

4 - 4 What to Install

Authorized Driver Message

If you receive a message telling you that the driver
you are installing is not authorized (Digital Signa-
ture Not Found), just click Yes or Continue Any-
way to ignore the message and continue the
installation procedure.

You will receive this message in cases where the
driver has been released after the version of Win-
dows you are currently using. All the drivers pro-
vided will have already received certification for
Windows.

Version Conflict Message

During driver installation if you encounter any “file
version conflict” message, please click Yes to
choose to keep the existing (newer) version.
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Windows 2000 (SP4) Internet Explorer 5.5 &
DirectX 8.1

Make sure that you install Internet Explorer 5.5 (or
higher version) if you are using the Windows 2000
(make sure Service Pack 4 is installed) OS.

Make sure that you go to the Microsoft website to
download and install DirectX 8.1 (or higher version)
if you are using the Windows 2000 (SP4) OS.

. |
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Updating/Reinstalling Individual
Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To
do this go to the Control Panel in the Windows OS
and double-click the Add/Remove Programs
item. If you see the individual driver listed (if not
see below), uninstall it, following the on screen
prompts (it may be necessary to restart the comput-
er). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the
driver in question.

If the driver is not listed in the Add/Remove Pro-
grams item:

1. Click Start (menu), point to Settings and click
Control Panel. Double-click System (icon)
and then click Hardware (tab) > Device Man-
ager (button).

2. Double-click the device you wish to update/
reinstall the driver for (you may need to click
‘C+’5).

3. Look for the Update Driver button (check the
Driver tab) and follow the on screen prompts.
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Feature Windows 2000 (SP4) Windows XP (SP1)
Service Pack Install the appropriate Service Pack for your system if not included in your Windows version
Chipset page 4 -8 page 4 - 11
D Internet Explorer Install IE 5.5 or higher N/A
DirectX 8.1 Install DirectX 8.1 or higher (download N/A
from the Microsoft website)
Audio page 4 -8 page 4 - 11
Video page 4 -8 page 4-12
Network (LAN) page 4-9 page 4-12
Modem page 4-9 page 4 -12
Hot-Key page 4-9 page 4-13
TouchPad page4-9 page 4-13
PC Card/PCMCIA (if required - see page 4 - 9) (if required - see page 4 - 13)
Wireless LAN See install procedure (depending on your computer model) on pages 7-2& 7 -5
Bluetooth See install procedure on pages 7-10& 7 - 12
Check Mail page 4-10 page 4 - 14
PC Camera See install procedure on pages 7-15& 7 - 16

Table 4 - [ - Install Procedure

4 - 6 What to Install
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Windows 2000 Professional

This section covers driver and utility installation in-

structions for Windows 2000 Professional. A ﬂ_

2 N
New Hardware Found Windows 2000 Service Pack 4
If you sce the message “New Hardware Found” Make sure you install Windows 2000 Service Pack
(Found New Hardware Wizard) during the 4 (or a version of Windows 2000 which includes
installation procedure (other than when outlined in ,SP|4)dbef°"e m:tt?IIu&gS;ng:nvers. Service Pack 4
the driver install procedure), click Cancel to close e s S er o
the WlndOW, alld fOllOW the lnStaHatIOIl pI‘OCCdul‘C If you have upgraded the System by |nsta”|ng Ser-
as directed. vice Pack 4 (i.e. your Windows 2000 version does

not include Service Pack 4) then follow these in-
structions:

1.Go to Device Manager (see step 1 of the PC Card
driver installation instructions on page ) and
click “+” next to Other devices (if its sub-items are
not shown).

2.Right-click Universal Serial Bus (USB) control-
ler and click Uninstall > OK.

3.Restart the computer and it will find the USB 2.0
controller.

Windows 2000 Professional 4 - 7
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Chipset (Win2000) Audio (Win2000)

1. Click Start (menu) > Run... 1. Click Start (menu) > Run...

2. Navigate (Browse..) to 2. Navigate (Browse..) to
D:\Drivers\inf_update\infinst_autol.exe and D:\Drivers\Audio\Setup.exe and click OK >
click OK. Next.

3. Click Next > Yes > Next. 3. Click Finish to restart the computer.

4. Click Finish to restart the computer. 4. You can click the AC97 Audio Configuration

icon @ in the taskbar for configuration options.

L%
s Video (Win2000)
Windows 2000 (SP_4) Internet Explorer 5.5 & 1. Click Start (menu) > Run...
Difectrs | 2. Navigate (Browse..) to
Make sure that you install Internet Explorer 5.5 (or D:\Drivers\VGA\Setup.exe and click OK.
higher version) if you are using the Windows 2000 3. Click Next > Yes.
(make sure Service Pack 4 is installed) OS. 4. Click Finish to restart the computer.
5. See “Advanced Video Controls” on page 3 - 2

Make sure that you go to the Microsoft website to
download and install DirectX 8.1 (or higher version)
if you are using the Windows 2000 (SP4) OS.

for details on adjusting the video settings.

Note: it is essential to install DirectX 8.1 if you want to
run the 3DMark program.

4 - 8 Windows 2000 Professional
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1. Click Start (menu) > Run...

2. Navigate (Browse..) to
D:\Drivers\Lan\Setup.exe and click OK.

3. Click Next.

4. Click Finish.

5. The network settings can now be configured.

Modem (Win2000)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to
D:\Drivers\Modem\Win2K\Setup.exe and
click OK.

. Click =21 (button).

. Click 1.

(G2 SN OS]

4

Modem Country Selection

Be sure to check if the modem country selection is ap-
propriate for you (Control Panel > Phone and Mo-
dem Options).

. The modem is ready for dial-up configuration.

Drivers & Utilities

Hot-Key (Win2000)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to D:\Drivers\Quick-
key\CNKO001.exe and click OK.

3. Choose the language you prefer, and click OK.

4. Click Next.

5. Click Finish to restart your computer.

TouchPad (Win2000)

1. Click Start (menu) > Run...

2. Navigate (Browse...) to
D:\Drivers\Touchpad\Win2K XP\Setup.exe
and click OK.

Click Next > Next > Next.

Click Finish to restart your computer.

You may then configure your TouchPad as
outlined in “Configuring the TouchPad and
Buttons” on page 2 - 20.

v kW

PC Card/PCMCIA (Win2000)

1. Click Start (menu), point to Settings and click
Control Panel. Double-click System (icon)
and then click Hardware (tab) > Device Man-
ager (button).

Windows 2000 Professional 4 - 9
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2. Click Device Manager (tab), then click “+”
next to PCMCIA adapters (if its sub-items are
not shown).

3. If you see Texas Instruments PCI-1410
CardBus Controller DO NOT install the
driver as it is not required.

OR
If you see Generic CardBus Controller then
follow these steps:

4. Double-click Generic CardBus Controller,

and click the Driver (tab).

. Click Update Driver (button) > Next.

When the Update Device Driver Wizard

appears, click Next (make sure that you have

selected “Search for a suitable driver for my
device (recommended)”) and click Next.

7. When Locate Driver Files appears, select
ONLY “Specify a location” and click Next.

8. Navigate (Browse...) to D:\Drivers\ENE-
PCMCIA\WIN2K.

9. Click Open > OK > Next.

10.Click Finish and close the open windows.

11.Click Yes to restart your computer.

N

Wireless LAN (Win2000)

See install procedure in “Gemtek USB Wireless
LAN Module” on page 7 - 2 for Model A comput-
ers, and “Intel PRO 2100 Mini PCI Wireless LAN
Module” on page 7 - 5 for Model B computers.

Bluetooth (Win2000)

See install procedure in “Bluetooth Driver Instal-
lation (Win2000)” on page 7 - 10.

Check Mail (Win2000)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to D:\Drivers\E-mail
LED\setup.exe and click OK.

3. To continue click OK, then click the Setup

button.

Click Continue > OK.

Click Yes to restart your computer.

The program will run upon startup.

For further details see “Check Mail Program”

on page 2 - 7.

PC Camera (Win2000)

See install procedure in “PC Camera Driver In-
stallation (Win2000)” on page 7 - 15.

Nk
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Windows XP

This section covers driver and utility installation in-
structions for Windows XP (Professional & Home).

Z &
Windows XP Service Pack 1

Make sure you install Windows XP Service Pack 1
(or a Windows XP version which includes Service
Pack 1) before installing any drivers. Service
Pack 1 includes support for USB 2.0.

If you have upgraded the system by installing Ser-
vice Pack 1 (i.e. your Windows XP version does not

include Service Pack 1) then follow these instruc-
tions:

1.Go to Device Manager (see step 1 of the PC Card
driver installation instructions on page ) and
click “+” next to Other devices (if its sub-items are
not shown).

2.Right-click Universal Serial Bus (USB) Control-
ler and select Uninstall > OK.

3.Restart the computer and it will find the USB 2.0
controller.

Drivers & Utilities

New Hardware Found

If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure, click Cancel to close the window,
and follow the installation procedure as directed.

Chipset (WinXP)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to
D:\Drivers\inf_update\infinst_autol.exe and
click OK.

3. Click Next > Yes > Next.

4. Click Finish to restart the computer.

Audio (WinXP)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to
D:\Drivers\Audio\Setup.exe and click OK >
Next.

Click Finish to restart the computer.

You can click the AC97 Audio Configuration
icon [@ in the taskbar for configuration options.

bl
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Video (WinXP) Modem (WinXP)

1. Click Start (menu) > Run... 1. Click Start (menu) > Run...

2. Navigate (Browse..) to 2. Navigate (Browse..) to
D:\Drivers\VGA\Setup.exe and click OK. D:\Drivers\Modem\WinXP\Setup.exe and

3. Click Next > Yes. click OK.

D 4. Click Finish to restart the computer. 3. Click [>>_1 (button).

5. See “Advanced Video Controls” on page 3 -2 4. Click 1.
for details on adjusting the video settings. 5. The modem is ready for dial-up configuration.

LAN (WinXP) /’

1. Click Start (menu) > Run...

. Modem Country Selection
2. Navigate (Browse..) to

D:\Drivers\Lan\Setup.exe and click OK. Be sure to check if the modem country selection is ap-
3. Click Next. propriate for you (Control Panel > Phone and Mo-
4. Click Finish. dem Options).
5. The network settings can now be configured.
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Hot-Key (WinXP)

1.
2.

Click Start (menu) > Run...
Navigate (Browse..) to D:\Drivers\Quick-
key\CNKO001.exe and click OK.

3. Choose the language you prefer, and click OK.
4.
5. Click Finish to restart your computer.

Click Next.

TouchPad (WinXP)

I.
2.

Click Start (menu) > Run...

Navigate (Browse...) to
D:\Drivers\Touchpad\Win2K XP\Setup.exe
and click OK.

. Click Next > Next > Next.

Click Finish to restart your computer.

. You may then configure your TouchPad as

outlined in “Configuring the TouchPad and
Buttons” on page 2 - 20.

PC Card/PCMCIA (WinXP)

1.

If you can see the My Computer icon on your
desktop (if you cannot see the My Computer
icon go to step 2) click on it once to select it,
then right-click it to make the sub-menu appear

% N

he

Drivers & Utilities

and scroll down to Properties and click on it
(go to step 3).

If you cannot see the My Computer icon click
Start (menu), then point to (but don’t click just
highlight it) My Computer. Right-click it to
make the sub-menu appear and scroll down to
Properties and click on it (go to step 3).

. Click the Hardware (tab), then click Device

Manager (button).
Click “+” next to PCMCIA adapters (if its
sub-items are not shown).

. If you see Texas Instruments PCI-1410

CardBus Contoller DO NOT install the driver
as it is not required.

OR

If you see Generic CardBus Controller then
follow these steps:

Double-click Generic Cardbus Controller
and click Driver (tab).

Click Update Driver (button).

When the Hardware Update Wizard appears,
click “Install from a list or specific location
(Advanced)” then click Next.

Select “Search for the best driver in these
locations.” and select ONLY “Include this
location in the search:”.
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10.Navigate (Browse...) to D:\Drivers\ENE-

PCMCIA\WINXP and click OK > Next.
11.Click Finish and close the open windows.
12.Restart your computer.

Wireless LAN (WinXP)

See install procedure in “Gemtek USB Wireless
LAN Module” on page 7 - 2 for Model A comput-
ers, and “Intel PRO 2100 Mini PCI Wireless LAN
Module” on page 7 - 5 for Model B computers.

Bluetooth (WinXP)

See install procedure in “Bluetooth Driver Instal-
lation (WinXP)” on page 7 - 12.

Check Mail (WinXP)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to D:\Drivers\E-mail
LED\setup.exe and click OK.

3. To continue click OK, then click the Setup
button.

4. Click Continue > OK.

5. Click Yes to restart your computer.

6. The program will run upon startup.
7. For further details see “Check Mail Program”
on page 2 - 7.

PC Camera (WinXP)

See install procedure in “PC Camera Driver In-
stallation (WinXP)” on page 7 - 16.

. |
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Chapter 5: BIOS Utilities ¢

0vel'VIeW Settings Warning

This chapter is about the computer’s built-in software. Incorrect settings can
' o cause your system to

Your computer comes with built-in BIOS (Basic Input Output System) malfunction. To correct

which is an essential set of software routines stored on a chip in your comput- mistakes return to the

er. These routines serve to describe your computer’s hardware to your chosen [l e i i LSl
. d id hterface bet 1 the t The BIOS in- menu and select the

operating system, and provides an interface betwee e two. 1he Default Settings and

cludes the POST (Power On Self Test) and the SCU (System Configuration click OK.

Utility). The POST performs diagnostic procedures at startup, the SCU al-

lows you to configure your computer.

There is one general rule: Don’t make any changes unless you are sure of
what you are doing. Many of the settings are required by the system, and
changing them could cause it to become unstable or worse. If you have any
doubts, consult your service representative.

If your computer has never been set up, or you are making important changes
to the system, then you should review this chapter first and note the original
settings found in the SCU. Even if you are a beginner, keep a record of the
settings you find and any changes you make. This information could be useful
if your system ever needs servicing.

. |
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4

The POST Screen

BIOS information
CPU type

Memory status
Enter SCU prompt
appears only during
POST

HON =

Note: The POST screen
as pictured above is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you choose the Fast
Boot option you will see
an abbreviated version
of this screen.

Figure 5 - 1
POST Screen
Pentium 4-M

Processor

The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to con-
duct a POST, including a quick test of the on-board RAM. As the POST pro-
ceeds, the computer will tell you if there is anything wrong. If there is a
problem which prevents the system from booting, it will display a system
summary and prompt you to run SCU.

If there are no problems, the SCU (System Configuration Utility) prompt
will disappear and the system will load the operating system. Once that starts,
you can’t get into the SCU without rebooting the computer.

Insyde Software MobilePro BIOS Version 1.01
Copyright 1983 - 2002 Insyde Software Corp. All Rights Reserved

H8 VERSION 04.15.03

1600MHz Pentium 4-M with MMX cpue
CPU Microcode Update Rev 01lh Complete
L2 Cache: 512K installed

8MB Video RAM
Insyde Software Plug-n-Play BIOS Ver 1.17.01

Base Memory 0000640 KB
Extended Memory 0252928 KB e
Total Memory 0253952 KB

Shared Memory 008192 KB

Auto Detecting IDE Devices [Done]

Ctrl-Alt-S to Enter System Configuration Utility o

5 - 2 The Power-On Self Test (POST)
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Insyde Software MobilePro BIOS Version 1.01
Copyright 1983 - 2002 Insyde Software Corp. All Rights Reserved

H8 VERSION 04.15.03

2o00mts catoron with wex v (€D) Figure 5 - 2

L2 Cache - 256K Installed

CPU Microcode Update Rev 01lh Complete POST Screen

L2 Cache: 512K installed
8MB Video RAM
Insyde Software Plug-n-Play BIOS Ver 1.17 Celeron

Base Memory 0000640 KB e Processor

Extended Memory 0252928 KB
Total Memory 0253952 KB
Shared Memory 008192 KB

Auto Detecting IDE Devices [Donel o

Ctrl-Alt-S to Enter System Configuration Utility

Insyde Software MobilePro BIOS Version 1.01
Copyright 1983 - 2002 Insyde Software Corp. All Rights Reserved

Figure 5 - 3
H8 VERSION 04.15.03
1400MEz Pentium ¥ with MMX CPU POST Screen

CPU Microcode Update Rev 01lh Complete

L2 Cache: 512K installed Pentium M

8MB Video RAM

Insyde Software Plug-n-Play BIOS Ver 1.17. Processor
Base Memory 0000640 KB

Extended Memory 0252928 KB e

Total Memory 0253952 KB

Shared Memory 008192 KB

Auto Detecting IDE Devices [Done]

Ctrl-Alt-S to Enter System Configuration Utility o

The Power-On Self Test (POST) 5 - 3
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Failing the POST

Errors can be detected during the POST. There are two categories, “fatal” and
“non-fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously
wrong with your system. Take the computer to your service representative or
authorized service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying
the problem (make a note of this message!) followed by the prompt:

* Press <FI1> to resume
* <Ctrl-Alt-S> to enter System Configuration Utility

Press F1 to see if the boot process can continue. It may work, without the cor-
rect configuration.

Press Ctrl-Alt-S simultaneously to run the SCU program and try to correct the
problem. If you still get an error message after you change the setting, or if the
“cure” seems even worse, call for help.

.|
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The System Configuration Utility

The SCU program tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration and power management). The
settings are stored in a nonvolatile battery and written to the CMOS RAM.
This means that the settings are saved even when the notebook is turned off.

Entering Setup

To enter the SCU, turn on the computer and press Ctrl-Alt-S simultaneously
when you see the prompt “<Ctrl-Alt-S> to enter System Configuration Utili-
ty”. The prompt seen in Figure 5 - 1 is usually present for a few seconds after
you turn on the system. If you get a “Keyboard Error” (usually because you
pressed Ctrl-Alt-S too quickly) just press Ctrl-Alt-S again.

If the computer is already on, reboot and then hold down Ctrl-Alt-S when you
see the prompt. The SCU’s main menu will appear.

BIOS Utilities

4

BIOS Settings V’s OS
Settings

Though many options
such as power man-
agement and display
settings may be set in
the BIOS, these are
usually best set in your
OS (e.g. Windows).

Older OS’s such as
DOS etc. may still rely
entirely on the setup
information from the
BIOS.  “Plug-n-Play”
OS’s, such as the vari-
ous Windows sys-
tems, may override
these settings with the
settings from the sys-
tem’s Control Panel.

The System Configuration Utility 5 - 5
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Working with the Menu Bar

You can use the mouse to navigate around the various menus and submenus
of the SCU, or alternatively, you can use the following key combinations:

Table 5 - 1 Keys Action
SCU Menu

Navigation Keys

Alt Activates the menu bar

Left arrow/Right arrow — «

. Selects an option in the menu bar
Type the highlighted letters

Left mouse button

Down arrow < Opens the pull-down menu bar
Spacebar options
Enter

Right mouse button

Cancels the action
Esc

5 - 6 Working with the Menu Bar
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Working with the Pull-Down Menu

Once your desired menu bar item is highlighted, press Enter or left-click with
the mouse to see the pull-down menu items. The following keys allow you to
move about the pull-down menu:

Keys Action Table 5 - 2
Pull-Down Menu
Down/Up arrows (3 1) Changes the value Keys

Allows you to choose:
Enter <OK> to save changes
<Cancel to ignore any changes>

Working with the Pull-Down Menu 5 - 7
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Working with Sub-Menus

/ Some pull-down menu options have an arrow to the right of the entry which
SCU Screens indicates a sub-menu is available. Choose these sub-menus by pressing Enter

, and the screen will be displayed. Navigate through these screens by using the
The screens which ap-

Seer @ (e el keys in the table below:
pages are intended as
a guideline. -
Keys Action
It should be noted that :
the screen on your par- Tab Moves from one field to another
ticular computer may " . L i
appear a little different- Down/Up arrows (v 1) Selects an item within the field
ly- Enables the specified function (a dot indicates the
Spacebar S
function is enabled)
OK/Enter Accepts the entg:\?easntc:]glgﬁzi tI;(: sub-menu and
Table 5 - 3 g
Sub Menus Cancel/Esc Rejects the entries and closes the sub-menu
(Right Arrow
Enabled)

5 - 8 Working with Sub-Menus
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Startup Menu

Figure 5 -4

Insyde Software SCU For Intel chipset Jul 3, 2003 9:40:02 am
Memory Disks Components Power Exit Startup Menu

[ |
Date and Time 4| — System

\ Fast Boot
Boot Device >
Display | 4 CPU Clock = 1400MHz
\ Enable Battery Low Beep
\ Enable Power On Beep
v Display OEM logo
_ Fast Boot for Windows XP

Boot Password

> — Memory
SCU Password >

Base = 640 KB

|I| Extended = 252928 KB
Shadow = 64 KB
Reserved = 320 KB
Total RAM = 253952 KB
Cache (Ext) = 1024 KB

Set system date and time

Fast Boot (Startup Menu)
Enable this option to eliminate the memory test and other delays at power-up.

Startup Menu 5 - 9



BIOS Utilities

Boot Device (Startup Menu)

Specify which device your computer should look on for an operating system
by priority. The most common setting is to look for the diskette “A:” first, then
the CD-ROM Drive (CD device), and lastly the Hard Disk “C:”. In most cas-
es your computer “boots” (starts-up from) the hard disk. There are cases where
you may want to “Boot” from a floppy disk in drive “A:” (use a USB floppy
drive), or the CD device. You may also set the computer to boot from the net-
work.

Display (Startup Menu)

Enables your choice of CRT (external monitor), LCD (the notebook’s display
screen), or both. These settings are best changed in your OS (see “ Display
Devices” on page 3 - 9), and may also be quickly adjusted by means of the Fn
and F6 keys (see “ Function Keys and Numeric Keypad” on page 2 - 17).
However if you want to use multiple display devices in OS’s other than Win-
dows, you may set the options here.

Enable Battery Low Beep (Startup Menu)
Enable or disable the low battery beep if the power is getting low.

Enable Power On Beep (Startup Menu)
Enable or disable the beep when the computer “boots up”.

5 - 10 Startup Menu
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Display OEM logo (Startup Menu)
Enable or disable (enabled by default) the display of the OEM logo (if appli- > Q;
cable) during the POST process.

Password Warning

Fast Boot for Windows XP (Startup Menu) If you choose to set a

Enable or disable (disabled by default) the fast system startup option if you boot password, NEV-

are using the Windows XP OS. ER forget your pass-
word.

Boot and SCU Passwords (Startup Menu) The consequences of

You can set the passwords for when the computer starts-up (Boot Password), this could be serious. If

and for access to the SCU to make changes (SCU password). See the sidebar you cannot remember

for a warning on setting the password. your boot password
you must contact your

vendor and you may
lose all of the informa-
tion on your hard disk.
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Memory Menu

17. 5 5 Insyde Software SCU For Intel chipset Mar 28, 2003 6:40:02 am
lgure - StartupDiSks Components Power Exit
Memory Menu |

et VGA Shared Memory W

Hard =

VGA Shared Memory = 1600MHz

VGA Shared Memory Size
) 8MB
() 1leMB
(-) 32MB

= 640 KB
‘ = 64 KB
= 320 KB

= 253952 KB

512 KB

Press (Alt) key to activate menus, and cursor keys to navigate. Mouse left
button, spacebar, and <Enter> keys accept menu item. Mouse right button and
<Esc> key cancel current action.

VGA Shared Memory

This is the pre-allocated memory size for VGA compatibility. This is fixed
at 32MB, and can be adjusted to SMB or 16MB. This memory is allocated
from your system memory e.g. if you computer has 128MB of memory
(RAM), then 32MB will be allocated to video leaving the system with
96MB of RAM.

5 - 12 Memory Menu
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Disks Menu

Insyde Software SCU For Intel chipset Mar 28, 2003 6:40:02 am Flgure 5 - 6
Startup Memory [ERSFN Components Power Exit [)-
isks Menu
[ |

— Devices IDE Settings P

_ Virus Alert

[X] Drive Enabled [X] Drive Enabled
[X] Multiple Sector Mode [X] PIO Mode
[X] PIO Mode

IDE UDMA-33/66/100 Function : Enable
IDE 32Bit I/O : Enable

(IDE Settings)

Press (Alt) key to activate menus, and cursor keys to navigate. Mouse left
button, spacebar, and <Enter> keys accept menu item. Mouse right button and
<Esc> key cancel current action.

IDE Settings (Disks Menu)
You can use this menu to set the options for your hard disk and CD device.
Only make changes if you are sure of what you are doing.

Virus Alerts (Disks Menu)

Enable this option to receive a warning if the area of the hard disk containing
information on how to start up the computer is having information written to
it. This can help warn you if viruses are attempting to affect this area. This is
not a substitute for proper virus protection supplied by updated anti-virus soft-
ware. This is merely an extra safeguard (see “Viruses” on page 8 - 4).
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Components Menu

Iragure 5 - 7 Insyde Software SCU For Intel chipset Jul 9, 2003 6:40:02 am
Startup Memory Disks Power Exit
Components Menu
— Devices N Keyboard Numlock _ System
Keyboard Repeat >
Hard Drive C = 2| gu Keyboardiype
N Enable Padlock
CPU Clock = 1400MHz

— Memory
Base = 640 KB
Extended = 252928 KB
Shadow = 64 KB
Reserved = 320 KB
Total RAM = 253952 KB
Cache (Ext) = 1024 KB

Enable the numeric key pad lock function by pressing Fn+NumLock and NumLock
LED is on. This hotkey has no function for Japanese keyboard.

Keyboard Numlock (Components Menu)]
Enable this mode to start the computer up with Number Lock enabled.

Keyboard Repeat (Components Menu)
Change the keyboard repeat rate and key delay from this menu.
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Keyboard Type (Components Menu)
Change the keyboard language type here.

Enable Padlock (Components Menu)

Activate Enable Padlock to be able to type the numbers from the numeric key-
pad without having to hold down the Fn key. You must have Number Lock
activated to be able to use this feature. Once Number Lock is activated, press
the Fn and Num Lock keys simultaneously to enable the Padlock mode (see
“Numeric Keypad” on page 2 - 18). When Padlock mode is enabled, and you
press the yellow typeface numeric keys, you will be able to type numbers di-
rectly without holding down the Fn key (holding Fn and pressing a key on the
numeric keypad will type a letter in this mode). To disable Padlock mode
press the Fn and Num Lock keys again.
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Power Menu

. Insyde Software SCU For Intel chipset Mar, 31 2003 6:40:02 am
Figure 5 -8

Startup Memory Disks Components Exit

Power Menu

— Devices —————m8M Low Power Saving

_ Medium Power Saving
Hard Drive C = 3000 _ High Power Saving
\ Customize >

CPU SpeedStep Controls »
N Turn on power for wireless devices and camera

Base = 640 KB
Extended = 252928 KB
Shadow = 64 KB
Reserved = 320 KB
Total RAM = 253952 KB
Cache (Ext) = 512 KB

4

Power for Wireless
Devices and Camera

Enable the power to wireless devices and camera. If not in use, please turn
off the power to these devices for power saving.

This menu allows you to set power saving options for systems other than Win-
The option to turn off dows. If you are using a Windows OS, then the power saving options are best

1L [P oIy TS set there (“Power Management Features” on page 3 - 17).
devices and camera is

only available for Mod-
el B computers.
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Low/Medium/High/Customize Power Saving (Power Menu)
You may choose to set power saving options for Low, Medium or High power 7&(
savings in this menu, or alternatively you may Customize the settings to T
change the time until the hard disk goes in to standby. These settings apply to c ontrorl)s Y CPB
Non-Windows operating systems only (Windows OS’s use the CPU Speed- Eerformance
Step Controls and/or the Windows Power Management/Options as outlined in

“Power Management Features” on page 3 - 17). The settings for CPU

SpeedStep Controls
will have an affect on
CPU SpeedStep Controls (Power Menu) the CPU’s speed and

You can set the mode for the Intel CPU SpeedStep controls here (“CPU JSaSiuEuceRRREICE
SpeedStep Control Settings” on page 3 - 24 gives full detail on the settings). to save power under

certain conditions).
See

* Performance Mode Always - Enable this option to give maximum avail-

able performance when the battery is not low. for

* Battery Optimized Mode Always - Enable this option to save maximum more details on how
power when the computer is powered by battery. the settings below con-
» Automatically Switch (Default Setting) - Enable this option to have the trol the CPU speed

computer detect if it is powered by battery or AC adapter, and change the and performance.

setting accordingly.

Turn on power for wireless devices and camera (Power Menu)
You may choose to enable/disable power for the wireless devices and camera
from this menu option.
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Exit Menu
Flgl/ll"e 5 _ 9 Insyde Software For Intel chipje;uwu Mar, 28 2003 6:40:02 am

Startup Memory Disks Component

Exit Menu s

Hard Drive C - 30007 MB

5

a
w
2

it
o

ave an
xi
e:
estore

E
De
Restore Settings

ed
Total RAM
Cache (Ext) =

ttings and return to previous work

Save and Exit (Exit Menu)
This option allows you to exit the SCU and save the changes you have made.

Exit (No Save) - (Exit Menu)
This option allows you to exit the SCU without saving any changes made.

Default Settings (Exit Menu)
This option allows you to reset the SCU settings to the original defaults before
any changes were made to the system.

Restore Settings (Exit Menu)
This option will allow you to restore the SCU settings to the last changes you
had made.

. |
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Chapter 6: Upgrading The Computer

Overview
This chapter contains information on upgrading the computer. Follow the ’ﬂ\
steps outlined to make the desired upgrades. If you have any trouble or prob- Warranty Warning

lems you can contact your service representative for further help. Before you

. . Please check with your
begin you will need: 4

service representative

before undertaking any
. upgrade procedures to
* A small regular slotted (flathead) screwdriver find out if this will VOID

* An antistatic wrist strap your warranty.

* A small crosshead or Phillips screwdriver

Before working with the internal components you will need to wear an anti-
static wrist strap to ground yourself because static electricity may damage the
components.

The chapter includes:

* Replacing the Battery

* Replacing the HDD

» Upgrading the System Memory
* Replacing the CD Device

Please make sure that you review each procedure before you perform it.

. |
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Upgrading The Computer
When Not to Upgrade

7&( These procedures involve opening the system’s case, adding and sometimes
replacing parts.

Power Safety
Warning

You should not perform any of these upgrades if:
Before you undertake

any upgrade proce- R . . .
dures, make sure that Your system is still under warranty or a service contract

you have turned off the * You don’t have all the necessary equipment
power, and discon- * You’re not in the correct environment

L EEE S« You doubt your abilities
and cables (including
telephone lines). It is . . )
advisable to also re- Under any of these conditions, contact your service representative to purchase
move your battery in or replace the component(s).

order to prevent acci-

dentally turning the

machine on.

6 - 2 Overview
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Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety 7<
reasons it is best to remove the battery. Warranty Warning
Battery Removal Process Please check with your
1. Turn the computer off, and turn it over. service representative

2. Locate the battery bay at point @). before undertaking any
3. Slide the battery lock @ in the direction of the arrow (towards the unlock upgrade procedures to

symbol Efl"), and hold it in place. find out if this will VOID
4. Slide the battery @ out of the computer’s battery bay. your warranty.

Figure 6 - 1
Battery Removal
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Upgrading The Computer
Upgrading the Hard Disk Drive

7£l§ The hard disk drive can be taken out to accommodate other 2.5" IDE hard disk
HDD System drives with a height of 9.5mm (h) (see “Storage” on page A - 2). Follow your
Warning operating system’s installation instructions, and install all necessary drivers
New HDD's are blank. and utilities (as outlined in “What to Install” on page 4 - 2), when setting up
Before you begin make a new hard disk.
sure: .
w8 Hard Disk Upgrade Process
data you want to keep 1. Turn off the computer, and turn it over and remove the battery.
];;ZT yr?:\:eOIdaI'l-lDtﬁé -] 2. Remove screws @ - @ from the hard disk cover, and remove the cover.
ROMs and FDDs re- 3. The procedure to follow now will depend on whether you have computer
quired to install your oper- Model A or Model B (see “Model Differences” on page 1 - 4). For
ating  system  and instructions for Model A see page 6-5, for Model B see page 6-6:

programs.
If you have access to the
internet, download the lat-
est application and hard-
ware driver updates for
the operating system you
plan to install. Copy these
to a removable medium.

Figure 6 - 2
HDD Cover Removal
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Hard Disk Removal (Model A)

1.
2.

3.
4.

Remove the cover (see page 6 - 4).

If you have the optional Wireless LAN module you will need to carefully
disconnect the cables at points @ & @.

Slide the hard disk assembly in the direction of the arrow €.

Lift the hard disk assembly up out off the computer, and remove screws Q -
@ in order to separate the cover from the hard disk.

Reverse the process to install a new hard disk (pay careful attention to the
orientation of the disk in the case, and do not forget to reconnect the WLAN
cables if necessary).

4

Ribbon Connectors
& Antenna Cable

To release these con-
nectors, use a small

flathead screwdriver to
gently pry the locking
collar away from its
base.

Figure 6 - 3
HDD Assembly
Removal
(Model A)
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Hard Disk Removal (Model B)

/ . 1. Remove the cover (see page 6 - 4).
2. Carefully disconnect the Wireless LAN antenna cable 0 Note: If you do not
Wireless LAN Module see the Mini-PCI board and cables etc. then the WLAN module is located on

the mainboard in your computer’s design. In this case follow steps 3 & 6.

e B e 3. Slide the hard disk assembly in the direction of the arrow @.

pry the WLAN antenna 4. Carefully lift the hard disk assembly up out off the computer (the cables Q
away from the & @ will be released as you lift out the hard disk and Mini-PCI board).

WLAN module. You 5. Remove screws 6 - 6 in order to separate the Mini-PCI board from the

can leave the WLAN hard disk @).

module attached to the 6. Reverse the process to install a new hard disk (pay careful attention to the

Mini-PClI board. orientation of the disk in the case).

Use a small flathead

Alternatively you can
remove the WLAN
module by releasing
the pins at the side of
module. The module
will pop-up, and you
can remove it. Don’t
forget to re attach the
. three cables.

Figure 6 - 4
HDD Assembly
Removal (Model B)
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Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line
(SO-DIMM) - DDR 200/266 MHz - type memory modules. The main memo-
ry can be expanded up to 1024MB. The SO-DIMMs supported are 128MB,
256MB, and 512MB in size, and the total memory size is automatically detect-
ed by the POST routine once you turn on your computer.

Memory Upgrade Process

1. Turn off the computer, and turn it over and remove the battery.

2. Remove screws @ - @ from the memory socket cover @), and remove the
cover by applying pressure at points @ & @.

Figure 6 - 5
Memory Socket Cover
Removal

Upgrading the System Memory (RAM) 6 - 7
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3. Gently pull the two release latches (@) & @ in Figure 6 - 6) on the sides
_ﬂ_ of the memory socket toward the sides of the computer.
AN

Contact Warning

Be careful not to touch
the metal pins on the
module’s  connecting

edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the

module’s perfor-
mance.
4. The module Q will pop-up, and you can remove it.
5. Pull the latches to release the second module if necessary.
6. Insert a new module holding it at about a 30° angle and fit the connectors
Figure 6 - 6 firmly into the memory slot.
. 7. The module’s pin alignment will allow it to only fit one way. Make sure the
Removing/ module is seated as far into the slot as it will go. DO NOT FORCE the
Installing a RAM module; it should fit without much pressure.
Module 8. Press the module in and down towards the mainboard until the slot levers

click into place to secure the module.
9. Replace the memory socket cover and the 4 screws (see Figure 6 - 5).
10. Restart the computer.

11. The BIOS will register the new memory configuration as it starts up.

6 - 8 Upgrading the System Memory (RAM)
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Upgrading the CD Device

The easy changeable CD device may be upgraded or changed.

CD Device Upgrade Process

Turn off the computer, and turn it over and remove the battery.

Remove screw @) from the CD Device screw cover @),and remove the
cover.

Apply pressure at point @ to push the CD Device @) out of the computer.
Reverse the process to install the new device.

1.

Figure 6 - 7
CD Device Removal
Procedure

Upgrading the CD Device 6 - 9
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Upgrading the Processor

’Q‘ If you want to upgrade your computer by replacing the existing processor with
Warranty a faster/new one you will need to contact your customer service representa-
tive. We recommend that you do not do this yourself, since if it is done incor-

The CPU is not a user .
rectly you may damage the processor or mainboard.

serviceable part.
Opening this compart-
ment, or accessing the

CPU in any way, may
violate your warranty.

Unauthorized tamper-
ing with the HDD may
also violate your war-
ranty.

6 - 10 Upgrading the Processor
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Chapter 7: Wireless & PC Camera i
Modules Wireless LAN

Modules
OVGWleW If your computer is
. . . . . Model A the Gemtek
This chqpter contains thg information on the w1rele§s and PC Camera mgd- USB Wireless LAN
ules which may come with your computer, depending on the configuration module is an optional
purchased. If you are unsure please contact your service representative. item, depending on

your purchase choice.

The chapter includes information on the following: If your computer is
Model B the Intel PRO
+ Gemtek USB Wireless LAN Module (Computer Model A as an Wireless LAN 2100

PCI module is included

optional feature only) as a standard item.

 Intel PRO Wireless LAN 2100 PCI Module (Computer Model B as a
standard feature)

* The Bluetooth Module

* The PC Camera

. |
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Gemtek USB Wireless LAN Module

\ o/
_ /ﬂ\ _ The Gemtek USB 802.11b Wireless LAN module is supplied as an option for
Wireless Device computer Model A only (see “Model Differences” on page 1 - 4).
Operation Aboard
Aircraft

Before installing the Gemtek USB 802.11b Wireless LAN driver, make sure
The use of any porta- that the Wireless LAN module is on (the ¢p) LED will be green). Use the Mod-
SERE ISR le ON/OFF Button (see “Module ON/OFF Button” on page 1 - 13) to toggle

mission devices . . . .
aboard aircraft is USu- power to the Wireless LAN module (make sure you install the drivers in the

ally prohibited. Make order indicated in Table 4 - 1 “- Install Procedure” on page 4-6).
sure the module(s) are

OFF if you are using

the computer aboard

aircraft. When your

computer ‘Boots Up’

the modules will be

ON.

. |
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Gemtek Wireless LAN Driver Installation (Win2000)

1. Click Start (menu) > Run...

2. Navigate (Browse..) to D:\Drivers\Wireless Lan\MiniUSBW-LAN.exe
and click OK.

3. Click Next > Yes > Next > Finish (click Yes or Continue Anyway if
asked if you want to continue at any time).

4. Double-Click the Wireless Monitor icon i in the taskbar to configure
the options from the control panel as illustrated below.

Figure 7 - 1
Gemtek Wireless
Monitor Control
Panels (Win2000)

| Gemitek Wireless:
Monitor

Wireless

&% Lirk Information 5 £y Avsiliable Metworks [P0

Metwork Name | Band | Signal Site Information

Current Profile String : I ® PRISM-5SID

A CT10 B 3 Metwork Type : Access Point
F PRISMESID B 100% Channel - 11
Ercryption : On
Surveped at:

00:30:4B:08:03:1C

wwrw.gemtek.com.tw www.gemtek. com.tw
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Figure 7 - 2
Gemtek Wireless
Network
Connection
Control Panel

Gemtek Wireless LAN Driver Installation (WinXP)

1.
2.

3.

Click Start (menu) > Run...

Navigate (Browse..) to D:\Drivers\Wireless Lan\MiniUSBW-LAN.exe

and click OK.

Click Next > Yes > Next > Finish (click Yes or Continue Anyway if
asked if you want to continue at any time).

After initially setting up the connection, you can double-click the Wire-
less Network Connection control panel to configure the options; click
Start (menu), point to Settings or Connect To, and click Network Con-
nections or Show all connections (alternatively you can right-click the
network icon in the taskbar as illustrated below).

Wireless Network Connection

The following wireless network(z] are available. To access a
wireless network, select it from the list, and then click Connect.

Available wireless networks:

Thiz wireless network, requires the use of a network key (WEF]. To
access this network, type the key, then click Connect.

Enable IEEE 802.1x authertication for this netwark.

If your are having difficulty connecting to a network, click Advanced,

LConnect ][ Cancel

MNetwork key: | |
| |

7 - 4 Gemtek USB Wireless LAN Module
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Intel PRO 2100 Mini PCIl Wireless LAN ﬁ
Module =

Wireless Device
The Intel PRO 2100 Mini PCI Wireless LAN module is supplied as a standard Operation Aboard

feature for computer Model B only (see “Model Differences” on page 1 - 4). Aircraft

The use of any porta-
Before installing the Intel PRO 2100 Mini PCI Wireless LAN driver, make ble electronic trans-

sure that the Wireless LAN module is on (the () LED will be green). Use the mission devices
Module ON/OFF Button (see “Module ON/OFF Button” on page I - 13) to [ iRl Eitis

. . . Il hibited. Mak
toggle power to the Wireless LAN module (make sure you install the driv- :u)r/e fr:(e) rlnolc?ule(s)aar:

ers in the order indicated in 7able 4 - 1 “- Install Procedure” on page 4-6). OFF if you are using
the computer aboard
aircraft. When your
computer ‘Boots Up’
the modules will be
ON.

To get help on the network settings you can view the User Guides by inserting
the Intel PRO CD-ROM and clicking View User Guides (button).

Intel PRO 2100 Mini PCI Wireless LAN Module 7 - 5
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Intel PRO 2100 Wireless LAN Driver Installation (Win2000)

bW =

o

10.
I1.
12.
13.

14.

Insert the Intel PRO CD-ROM into the CD drive.

Click Wireless LAN Adapters (button).

Click Install Software (button).

Click Next.

Click the button to accept the license and click Next > Next > Install >
Finish.

Click Start (menu), point to Settings and click Control Panel. Double-
click System (icon) and then click Hardware (tab) > Device Manager
(button).

Click Device Manager (tab), then click “+” next to Other Devices (if its
sub-items are not shown).

Double-click Network Controller, and click the Reinstall Driver (but-
ton).

When the Update Device Driver Wizard appears, click Next (make sure
that you have selected “Search for a suitable driver for my device
(recommended)”) and click Next.

When Locate Driver Files appears, select ONLY “Specify a location”
and click Next.

Navigate (Browse...) to D:\ProW2100\PROW7100\WIN2K.

Click Open > OK > Next.

Input your network name and click Next, then select your network set-
tings and click Next.

Click Finish and close the open windows.

You can now install the Administration Tools (see overleaf).
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Insert the Intel PRO CD-ROM into the CD drive.

Finish.

You can configure the settings by going to the Start menu and pointing
to Programs and clicking Intel Network Adapters, then clicking either
the Intel (R) PROset icon, or the options under the Access Point

Make sure that you in-
stall Internet Explorer

1.

2. Click Wireless LAN Adapters (button). ﬁ

3. Click Install Administration Tools (button).

4. Click Next. Windows 2000

5. Click the button to accept the license and click Next > Next > Install > Internet Explorer 5.5
6.

5.5 (or higher ver-
P . sion) if you are using
Administration Tools. the Windows 2000

OS.

You can view the User Guides by inserting the Intel PRO CD-ROM and click-
ing Wireless LAN Adapters (button) > View User Guides (button).

Intel® PRO Network Connections

Intel* PRO Network
Connections
intel N Intel PROMireless LAN Adapters

T =

Figure 7 - 3
View User Guides
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Intel PRO 2100 Wireless LAN Driver Installation (WinXP)

Insert the Intel PRO CD-ROM into the CD drive.

Click Wireless LAN Adapters (button).

Click Install Software (button).

Click Next.

Click the button to accept the license and click Next > Next > Install >

Finish.

If you can see the My Computer icon on your desktop (if you cannot see

the My Computer icon go to step 7) click on it once to select it, then

right-click it to make the sub-menu appear and scroll down to Properties

and click on it (go to step 8).

7. If you cannot see the My Computer icon click Start (menu), then point
to (but don’t click just highlight it) My Computer. Right-click it to make
the sub-menu appear and scroll down to Properties and click on it (go to
step 3).

8. Click the Hardware (tab), then click Device Manager (button).

9. Click “+” next to Other Devices (if its sub-items are not shown).

10. Double-click Network Controller and click Reinstall Driver (button).

11. When the Hardware Update Wizard appears, click “Install from a list
or specific location (Advanced)” then click Next.

12. Select “Search for the best driver in these locations.” and select
ONLY “Include this location in the search:”.

13. Navigate (Browse...) to D:\Prow2100\PROW7100\WINXP and click
OK > Next.

14. Click Finish and close the open windows.

bW =

o

You can now install the Administration Tools (see overleaf).
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1. Insert the Intel PRO CD-ROM into the CD drive.

2. Click Wireless LAN Adapters (button).

3. Click Install Administration Tools (button).

4. Click Next.

5. Click the button to accept the license and click Next > Next > Install >
Finish.

6.

You can configure the settings by going to the Start menu and pointing
to Programs/All Programs and clicking Intel Network Adapters, then
clicking either the Intel (R) PROset icon, or the options under the
Access Point Administration Tools.

You can view the User Guides by inserting the Intel PRO CD-ROM and click-
ing Wireless LAN Adapters (button) > View User Guides (button).

Intel® PRO Network Connections

Intel* PRO Network
Connections
inbl I Intel PROMireless LAN Adapters

Install Software

¢ Install Administration Tools

Figure 7 - 4
View User Guides
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1%

Wireless Device
Operation Aboard
Aircraft

The use of any porta-
ble electronic trans-
mission devices

aboard aircraft is usu-
ally prohibited. Make
sure the module(s) are
OFF if you are using
the computer aboard

aircraft. When your
computer ‘Boots Up’
the modules will be
ON.

Wireless & PC Camera Modules

Bluetooth Module

Before installing the Bluetooth driver, make sure that the optional Bluetooth
module is on (the ¢ LED will be green). Use the Module ON/OFF Button
(see “Module ON/OFF Button” on page 1 - 13) to toggle power to the Blue-
tooth module (if the Found New Hardware Wizard appears, click Cancel).
Make sure you install the drivers in the order indicated in 7able 4 - I - In-
stall Procedure’ on page 4-6.

Bluetooth Driver Installation (Win2000)

Insert the Bluetooth CD-ROM into the CD drive.

The program will run automatically.

If the Found New Hardware Wizard appears, click Cancel, and click OK
if you see Unsafe Removal of Device.

Click Start (menu) > Run...

Navigate (Browse...) to the top level of the CD D:\ and click OK.

Click Install Drivers and Application Software and click Next.

Click the button to accept the license agreement, then click Next.

Click Next > Install (click OK if asked if you want to continue).

Click Finish > Yes to restart the computer.

. You can configure the settings in the Bluetooth Configuration control

panel (Start menu and point to Settings and click Control Panel then
double-click the Bluetooth Configuration icon).

The Bluetooth Manual (in .html format) is on the Bluetooth CD-ROM in the
Userguide folder (insert the Bluetooth CD-ROM and click Browse this CD).
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Bluetooth Driver Audio Setup (Win2000)

After installing the Bluetooth driver in Windows 2000 you may no longer hear
any sound, nor see the Volume icon in the taskbar. If this is the case then fol-
low this procedure:

1. Go to the Sounds & Multimedia Control Panel (Start Menu and point to

Settings and click Control Panel then double-click the Sounds & Multime-

diaicon).

Click the Audio tab.

In the Sound Playback and Sound Recording menus choose Realtek

AC97 Audio.

4. Click the Sounds tab and make sure that the tickbox to “Show volume
control on the taskbar” is ticked.

5. Click OK.

SEN

. |
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Bluetooth Driver Installation (WinXP)

Insert the Bluetooth CD-ROM into the CD drive.

The program will run automatically.

Click Install Drivers and Application Software and click Next.

Click the button to accept the license agreement, then click Next.

Click Next > Install (click OK if asked if you want to continue).

When the Found New Hardware Wizard appears select “Install from a

list or specific location (Advanced)” then click Next.

7. Select “Search for the best driver in these locations.” and select
ONLY “Include this location in the search:”.

8. Navigate (Browse...) to the top level of the CD D:\ and click OK > Next
> Finish (click Continue Anyway if asked if you want to continue),
then restart the computer.

9. You can configure the settings in the Bluetooth Configuration control

panel (Start menu and point to Settings and click Control Panel then

double-click the Bluetooth Configuration icon).

QUnhE WD —

The Bluetooth Manual (in .html format) is on the Bluetooth CD-ROM in the
Userguide folder (insert the Bluetooth CD-ROM and click Browse this CD).

. |
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Bluetooth Control Panel Options
You may need to change some control panel options after installing the Blue-
tooth driver:

Audio

1. Go to the Start menu and point to Settings (or just click Control Panel) and
click Control Panel, then double-click the Sounds & Audio Devices/
Sounds & Multimedia icon (Category View > Speech, and Audio
Devices).

2. Click Audio (tab) and make sure that the “Default device:” is Realtek
AC97 Audio.

Hyper Terminal

1. Go to Start menu and click Programs/All Programs, then point to Acces-
sories > Communications > HyperTerminal.

2. Double-Click your connection, and make sure you have selected “Connect
Using:” Smart Link 56K Voice Modem.

FAX (WinXP)

1. Go to the Start menu and point to Settings (or just click Control Panel) and
click Control Panel, then double-click the Printers and Faxes icon (Cate-
gory View > Printers and Other Hardware).

Double-click your fax icon to bring up the Fax Console.

Click the Tools menu and scroll down to “Configure Fax...”.

Click Next > Next and make sure that the fax device is the Smart Link 56K
Voice Modem.

PoDd
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FAX (Win2000)

1.

2.

3.

7 - 14 Bluetooth Module

Go to the Start menu and point to Settings and click Control Panel, then
double-click the Fax icon.

Click Advanced Options (tab) and click the Open Fax Service
Management Console (button).

Click Devices in the Tree window on the left.

The fax devices will be displayed in the right window, with the device with
the highest priority displayed at the top.

Select the Smart Link 56K Voice Modem and use the arrows to move it to
the top of the priority list, then close the windows.
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PC Camera
If you have purchased the optional PC Camera you will need to install the de- &
vice driver for it as indicated on the following pages (make sure you install Taking Still Pictures

the drivers in the order indicated in Table 4 - 1 - Install Procedure’ on You may take still pic-
page 4-6). Use the Module ON/OFF Button (see “Module ON/OFF Button” tures in the Windows
on page 1 - 13) to toggle power to the PC Camera module. XP operating system
only.

Double-click the My
Computer icon on the

After installing the driver you can run the application software by going to the
CMM PC Camera item in the Start > Programs/All Programs menu and

selecting the AMCAP program. desktop, or go the
Start menu and point
PC Camera Driver Installation (Win2000) to My Computer, then
1. Insert the PC Camera CD-ROM into the drive. olick it .
2. Click Next (click Yes if asked if you want to continue at any time). Double-click the CMM
3. Click Finish to restart the computer. PC Camera icon.
4. After restart the computer will find the new hardware for you (click Yes =
if asked if you want to continue at any time). @ RIS
5. To run the application software go to the CMM PC Camera item in the
Start > Programs/All Programs menu, and select the AMCAP pro- Click Take a new pic-
gram. ture in the Camera
Tasks box.
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7 - 16 PC Camera

PC Camera Driver Installation (WinXP)

1.
2.

3.
4.

Insert the PC Camera CD-ROM into the drive.

Click Next (click Continue Anyway if asked if you want to continue at
any time).

Click Finish to restart the computer.

After restart allow some time for the computer to bring up the Found
New Hardware Wizard (or click the message in the taskbar).

Click “Install from a list or specific location (Advanced)” then click
Next.

Select “Search for the best driver in these locations.” and select
ONLY “Include this location in the search:”.

Navigate (Browse...) to the PC Camera CD-ROM and click OK > Next
> Finish (click Continue Anyway if asked if you want to continue).
Click Yes to restart the computer.

To run the application software go to the CMM PC Camera item in the
Start > Programs/All Programs menu, and select the AMCAP pro-
gram.
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PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup
the audio recording options in Windows.

(WinXP)

1. Go to the Start menu and point to Settings (or just click Control Panel) and

click Control Panel, then double-click the Sounds & Audio Devices icon

(Category View > Speech, and Audio Devices).

Click Advanced in the Volume tab.

Click Options (Volume Control) and scroll down and click Properties.

Click Recording (Adjust volume for) and click Microphone (check box),

then click OK.

5. Make sure the Select (check box) in the Recording Control panel, under
the Microphone section, is checked (boost the volume as high as it will go).

6. Close the open windows.

PoDd

(Win2000)

1. Go to the Start menu and point to Settings and click Control Panel then
double-click the Sounds and Multimedia icon.

2. Click Audio (tab) and click Volume (button) in the Sound Recording menu.

3. Select Advanced Controls from the Options menu.

4. Make sure the Select (check box) in the Microphone section is checked,
and boost the volume as high as it will go.

5. Close the windows.
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Figure 7 -5
Audio Setup
(Windows XP)
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Wireless & PC Camera Modules

AMCAP

AMCAP is a video viewer useful for general purpose video viewing and test-
ing, and can capture video files to .avi format.

1. Runthe AMCAP program from the Start > Programs/All Programs > CMM
PC Camera menu (it is recommended that you set the capture file before
the capture process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio make sure
that the Capture Audio option is ticked) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will

be asked to choose a file name and size (see the sidebar - Pre-Allocating

File Space) for the captured file. Click Start Capture again.

Click OK to start capturing the video, and press Esc to stop the capture.

5. If you wish to, you may go to the File menu and select Save Captured
Video As..., choose a file name and location, then click Open (you can view
the file using the Windows Media Player).

B

Set Capture File

In AMCAP program you will only be asked to set the capture file name on the
first run of the program. When you run the program the next time the file will
automatically be overwritten with the newly captured file. To avoid overwrit-
ing files you can go to the Set Capture File.. option in the File menu, and set
the file name and location before capture. Set the name and location then click
Open (you can choose Cancel to ignore the file size if prompted).

PC Camera 7 - 19

4

Pre-Allocating File
Space

You may pre-allocate
the file size for the cap-
ture file in the AMCAP
program. You can
choose to ignore this
by clicking Cancel.

Pre-allocating space
on the hard disk can
improve the capture
quality (particularly of
large capture files), by
reducing the amount of
work the hard disk has
to do in finding space
for the video data as it
is being captured.

You may find it helpful
to defragment the HDD
before capture.
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Eliminating Screen Flicker
If you find that the video screen in the AMCAP program is flickering, you can
try to adjust the option from the Video Capture Filter options.

1.  Runthe AMCAP program from the Start > Programs/All Programs > CMM
PC Camera menu.

2. Go to Options and scroll down to select “Video Capture Filter...”.

3. You can choose either 50Hz or 60Hz from the No Flicker box.

Properties E‘
{Camers Coriiols |
Figure 7 - 6
Image Cortrol Default
Camera Controls Brightness — [ @ Resst
7 Contrast ——— p—-—— 20 Save
Gamma | —————————— 4 i
Hue | 18 | [T wertical Fiip
Saturation } gy | ¥ Golor Enable
o ™ Mirrar Flip
arpness — i
[~ Backlight Comp

Red 1
Green |
Blue |}

¥ &uto Enable

. |
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Troubleshooting

Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you
may want to try to solve the problem yourself. This chapter lists some common problems and their possible
solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t
find the answer in these pages, make sure you have followed the instructions carefully and observed the
safety precautions in the preface. If all else fails, talk to your service representative. You should also make
a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should

preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try

turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start work- a
ing again. Then call your service representative.

. |
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Troubleshooting

Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer
appears not to be working.

* Power - Is the computer actually plugged into a working electrical outlet? If plugged into a
power strip, make sure it is actually working. Check the LED Power Indicators (see “LED
Power & Communication Indicators” on page 2 - 6) to see the computer’s power status.

* Connections - Check all the cables to make sure that there are no loose connections anywhere.

» Power Savings - Make sure that the system is not in Hibernate or Standby mode by pressing the
keys configured in your Power Management/Power Options (see “Conserving Power (System)”
on page 3 - 25), or by pressing the Fn + Esc key combination, to wake-up the system.

* Brightness - Check the brightness of the screen by pressing the Fn + F9 and F10 keys to adjust
the brightness (see “Advanced Video Controls” on page 3 - 2).

* Display Choice - Press Fn + F6 to make sure the system is not set to “external only” display (see
“Switching/Enabling Displays (Keyboard)” on page 3 - 9).

* Boot Drive - Make sure there are no floppy disks in the drive (if you have one connected) when
you start up your machine (this is a common cause of the message “Invalid system disk - Replace
the disk, and then press any key” /| “Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance

* Always backup your important data, and keep copies of your OS and programs safe, but close to
hand. Don’t forget to note the serial numbers if you are storing them out of their original cases,
e.g. in a CD wallet.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule
these programs to run at times when you are not using your computer. You can use those that are
provided free with your OS, or buy the more powerful dedicated programs to do so.

*  Write down your passwords and keep them safe (away from your computer). This is especially
important if you choose to use a Startup password for the SCU (see “Startup Menu” on page 5 -
9).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just

brief notes).
2 &

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate
your warranty.
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Viruses

Install an Anti-Virus program and keep the definitions file (the file which tells your program
which viruses to look for) up to date. New computer viruses are discovered daily, and some of
them may seriously harm your computer and cause you to lose data. Anti-Virus programs are
commercially available and the definitions file updates are usually downloadable directly from
the internet.

Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from
within e-mail attachments so take care when opening any attached file. You can configure most
Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files
from people you know as the virus may have infected an address book and been automatically
forwarded without the person’s knowledge.

Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk provides basic information
which allows you to startup your computer) handy. You may refer to your OS’s documentation for
instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or
at least instructions on how to make one).

8 - 4 Viruses
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Upgradlng and Adding New Hardware/Software

Do not be tempted to make changes to your Windows Registry unless you are very sure of what
you are doing, otherwise you will risk severely damaging your system.

* Don’t open your computer or undertake any repair or upgrade work if you are not comfortable
with what you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the
computer’s manual, but what about any new peripheral devices you have just purchased? Many
problems are caused by the installation of new hardware and/or software. Always refer to the doc-
umentation of any new hardware and/or software, and pay particular attention to files entitled
“READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you
will need to restart the computer. Always check that all the cables are correctly connected.

* Make sure you have installed the drivers for any new hardware you have installed (latest driver
files are usually available to download from vendor’s websites).

Upgrading and Adding New Hardware/Software 8 - 5
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» Thoroughly check any recent changes you made to your system as these changes may affect one
or more system components, or software programs. If possible, go back and undo the change you
just made and see if the problem still occurs.

* Don’t over complicate things. The less you have to deal with then the easier the source of the
problem may be found; Example - if your computer has many devices plugged into its ports, and
a number of programs running, then it will be difficult to determine the cause of a problem. Try
disconnecting all of the devices and restarting the computer with all the peripheral devices
unplugged. A process of elimination (adding and removing devices and restarting where neces-
sary) will often find the source of a problem, although this may be time consuming.

.|
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Troubleshooting

Problem

Possible Cause - Solution

You turned on the power
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is
present and seated properly (the design of the battery only allows it to go in one way).
Make sure there’s nothing interfering with the battery contacts.

The Battery LED power
indicator 1, is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately,
turn it off then on again.

The system has power
but no picture appears.

The sleep/resume key combination, Fn + Esc, or other configured key combination, has
been toggled. Press Fn + Esc, or other configured key combination. Wait a few moments
before trying this control again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see
“Power Schemes” on page 3 - 19) check its settings. You may also be using a PC Card
device that is drawing a lot of power.

The notebook feels too
hot.

Make sure the notebook is properly ventilated and the fan port is not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make
sure the vents aren’t blocked and the computer isn'’t sitting on a thermal surface (see
“Overheating” on page 1 - 19). Make sure you’re using the correct adapter.

The battery pack will not
charge.

The battery pack is exposed to an excessively hot or cold environment. Place the battery
in a suitable environment and after it returns to normal temperature try again. The battery
may be bad and may need to be replaced, contact your service center for more details.

. |
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Problem Possible Cause - Solution

The battery pack will not The battery is already fully charged and the indicator light is broken.
charge and the charge
indicator light is off.

Abeeping sound is heard | The battery power is nearly used up. Connect the AC adapter to your computer.
and the low-battery
indicator is on.

A beep isn’t heard when The battery power is nearly used up and the volume control may be turned down. Adjust
the low-battery indicator the volume control and connect the computer with the AC adapter.

turns on, or the gauge
indicates power is less

than 10%.

Actual battery operating The battery has not been fully discharged before being recharged. Make sure the battery
time is shorter than is fully discharged and recharge it completely before reusing (see “Battery Information”
expected. on page 3 - 28).

Power Options have been disabled. Go to the Control Panel in Windows and re-enable
the options.

A peripheral device or PC Card is consuming a lot of power. Turn off the unused device to
save power.
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Display

Problem Possible Cause - Solution
Nothing appears on The system is in a power saving mode. Toggle the sleep/resume key combination, Fn +
screen. Esc (see “Function Keys and Numeric Keypad” on page 2 - 17).

The screen controls need to be adjusted. Toggle the screen control key combinations Fn +
F9/F10 (see “Opening the LCD” on page 3 - 2). If you're connected to an external
monitor, make sure it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key combination, Fn
+ F6 (see “Switching/Enabling Displays (Keyboard)” on page 3 - 9). If an external
monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

.|
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Problem Possible Cause - Solution
The screen is flickering, The vertical refresh rate is insufficient on your external monitor. Avoid using the
or the images aren’t Simultaneous display mode. Use LCD only or CRT only. Switch to a lower resolution and/
clear. or fewer colors, and adjust the refresh frequency in the display controls (see “Vertical

Refresh Rate” on page 3 - 10).

The viewing angle of the LCD is bad. Adjust the position of the LCD. LCD'’s are designed
to be viewed “straight on”. If the angle is wrong, you may see glare from the screen’s
backlight.

The screen is dirty. Clean the screen using a soft, clean dry cloth. Many cleaning solutions
can damage the LCD surface so you should follow the precautions outlined in the Preface.
Try to avoid touching the screen itself. Even the cleanest hands can leave oils which
attract contaminants.

No image appears onthe | You haven’t used the key combination to switch the display options. Press the Fn + F6 key

external monitor | have combination to toggle through the options.
plugged in and powered You haven’t installed the video driver and configured it appropriately from the Control
on. Panel. See “What to Install” on page 4 - 2 for instructions on installing the driver, and

see “Making Adjustments for the Display” on page 3 - 4 for instructions on configuring
the video driver.

.|
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Hard Disk & Boot Password

Problem Possible Cause - Solution
The computer takes Data saved on the hard disk drive may be lost or damaged. Operate the scan disk or disk
longer during Startup. defragmenter to check for any lost or damaged data.

The computer is waking up from the Hibernate mode.

Problem Possible Cause - Solution
You forget the boot If you forget the password, you may have to discharge the battery of the CMOS. Contact
password. your service representative for help.

2NZ
2 &
Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot

remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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USB Floppy Disk Drive

Problem Possible Cause - Solution

The floppy disk drive will The floppy disk is not formatted. Format the disk (you may do this by right-clicking the disk
not write data to disk. icon in My Computer in Windows and choosing Format from the menu). Bear in mind that
this will erase all data contained on the floppy disk.

Note: Floppy disks were never intended for long-term data storage, and have a finite life
span. Do not store important files you wish to keep for a long time on floppy disks. As a
general rule it is worth reformatting floppy disks regularly.

The floppy disk is write-protected. Undo the protection by moving the write-protect tab on
the disk down until it clicks.

There is not enough unused space available on the disk. Use a new disk or delete any
unneeded data.

The message “Invalid The computer is trying to boot from an incorrect floppy disk. Remove the floppy and insert
system disk - Replace a correct one, or boot from your hard disk or CD. You will need to restart the computer.
the disk, and then

press any key’”/
“Remove disks or other
media. Press any key
to restart” appears.
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Audio & CD Device

Problem Possible Cause - Solution
The sound cannot be The volume might be set too low. Check the volume control in the Volume Control Panel
heard or the volume is in the Windows taskbar, or use the key combination Fn + F11 and F12 (see “Function
very low. Keys and Numeric Keypad” on page 2 - 17) to adjust.

The headphone is plugged into the wrong jack. It should be plugged into the headphone-
out jack (see “Headphone-Out Jack” on page 1 - 17).

The sound cannot be The Equalizer settings in the Audio Configuration control panel is set too low. Click the
heard or the volume is AC97 Audio Configuration icon [ in the taskbar for configuration options. Select the
very low when playing a Equalizer tab, and click the ON tickbox. Make sure that all the sliders are set to the top
Video CD. level (+12dB), then click OK and close the open windows.

Problem Possible Cause - Solution

The compact disc cannot | The compact disc is dirty. Clean it with a CD-ROM cleaner kit.
be read.

The compact disc tray The compact disc is not correctly placed in the tray. Gently try to remove the disc using the
will not open when there | eject hole (see “Loading Discs” on page 2 - 11).
is a disc in the tray.
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Problem

Possible Cause - Solution

The DVD regional codes
can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on
page 2 - 13.

A music compact disc
can be read while a data
disc can not.

There may be a problem with the disc hardware or software. Refer to your operating
system manual for more information on the software and make sure you have the correct
software installed for running video compact discs. If the proper software is installed and a
problem still exists, contact your service center about a possible hardware problem.

All compact discs cannot
be read.

The Windows system does not recognize the CD-ROM drive, or the CD-ROM drive is not
compatible with other devices. Make sure you have the CD-ROM drive properly installed
and configured.

The CD-ROM drive is dirty. Clean it with a CD-ROM cleaner kit.

There may be a problem with the disc hardware or software. If the correct software is
properly installed, contact your service center about a hardware problem.

the hole.

2N\
L&
Media Warning
When manually ejecting a CD/DVD, DO NOT use a sharpened pencil or similar object which may break, and become lodged in
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PC Card

Problem Possible Cause - Solution
The system cannot The PC Card is not inserted into the socket or inserted incorrectly. Remove the card and
recognize the PC Card. re-insert it aligning the PC Card with the slot. Push the card in until it locks into place.

The PC Card or card driver is not compatible with the computer. Check “PC Card” on
page A - 2 to check the compatibility of the card.

The PC Card driver is not installed. Install the driver (see “What to Install” on page 4 - 2).

The system cannot access the card after it is installed. Please read the documentation
which comes with any new external device. Make sure you install any drivers, if they are
supplied with it, as this will allow you to access any extra functions which come with the
device.

. |
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Keyboard and Mouse

Problem Possible Cause - Solution
Unwelcome numbers Ifthe LED ﬁ is lit, then Num Lock is turned ON. Check that Padlock mode is not enabled
appear when typing. (see “Numeric Keypad” on page 2 - 18).
| have installed a new You have not installed the driver to enable any extra functions. Make sure you read the
external keyboard or documentation which comes with any new external device, and make sure you install the
mouse but cannot use all | driver for it as this will allow you to access any extra functions which come with your
of the listed functions. device.

D Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The
system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular
keyboard may not work.

.|
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Printer
Problem Possible Cause - Solution
The printer cannot be The printer is not turned on, is not correctly connected to the computer, or has an internal
added to the system or problem. Make sure the printer is on. Check all connections and cables and then try to
will not work. reinstall the driver. You may refer to the printer’'s manual for instructions on printing a “self-

test” page (a “self-test” page will print regardless of computer connections and is a means
of ensuring that the printer is actually working).

There is no paper in the printer, or the paper is incorrect for the settings designated in your
software. Put more paper in the printer (also fan the paper to make sure it doesn’t stick
together and cause a paper jam) and check the paper size matches your software’s “print”
settings.

The printer driver is not installed or is configured incorrectly. Check that the printer is
properly installed and configured (correct port etc.). Also check that you have installed the
latest driver compatible with your OS (updated drivers are usually available for download
from the printer manufacturer’s website).

The printer is a network printer and it is not properly connected to the network. All
networks are configured differently so please check with your network administrator to
get the correct setup.
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Operation
Problem Possible Cause - Solution
The system freezes or The system’s power saving features have timed-out. Use the AC adapter, press the sleep
the screen goes dark. (Fn + Esc) key combination, or press the power button if no LEDs are lit.

A software conflict made the system “crash”. Consult your OS manual. As a last resort,
since you will lose any unsaved data, try to reboot the system or if that doesn’t work, turn
the computer off and on again.

The system never goes Make sure you have enabled Hibernate in the Power Options control panel in your OS
into Hibernate mode. (see “Hibernate” on page 3 - 26).

The system does not go No power saving options are enabled. Use one of the Power Options presets.
into a power saving
mode when the battery is
low.
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Modules
Problem Possible Cause - Solution
The Wireless LAN/ The modules are off. Check the LED indicator (((;))) to see if the modules are on or off (see
Bluetooth/PC Camera “LED Status Indicators” on page 2 - 5). If the LED indicator is off, then press the Module
modules cannot be On/Off button in order to enable the modules (see “Gemtek USB Wireless LAN Module”
detected. on page 7 - 2, “Intel PRO 2100 Mini PCI Wireless LAN Module” on page 7 - 5,
“Bluetooth Module” on page 7 - 10 and/or “PC Camera” on page 7 - 15).
The Wireless LAN/ The driver(s) for the module(s) have not been installed. Make sure you have installed the
Bluetooth/PC Camera driver for the appropriate module (see “Gemtek USB Wireless LAN Module” on page 7
modules cannot be - 2, “Intel PRO 2100 Mini PCI Wireless LAN Module” on page 7 - 5, “Bluetooth
configured. Module” on page 7 - 10 and/or “PC Camera” on page 7 - 15).
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Appendix A. Model A Specifications

Processor Options

* Mobile Intel Pentium® 4 Processor-M - (478-
pin) Micro-FCPGA package

(10.13) 0.13 Micron Process Technology, 512KB
On-die L2 Cache & 400MHz PSB - 1.4/ 1.5/ 1.6/
1.7/1.8/1.9/2.0/2.2/ 2.4/ 2.5 /2.6 GHz

* Mobile Intel Celeron® Processor - (478-pin)
Micro-FCPGA package

(10.13) 0.13 Micron Process Technology, 256KB
On-die L2 Cache & 400MHz PSB -1.4/ 1.5/ 1.6/
1.7/1.8/2.0/2.2 GHz

d

Processor Types

You can check your processor type from the POST
screen “The Power-On Self Test (POST)” on
page 5 - 2.

Core Logic
« Intel 852GM + ICH4-M

Structure

* PC2001 Compliant
* PCI 2.2 Compliant
* ACPI 2.0 Compliant

Security
* Security (Kensington® Type) Lock Slot
* BIOS Password

Memory

* Two 200-pin SODIMM sockets, supporting 200/

266 MHz DDR modules

* Memory expandable up to 1GB (128/ 256/ 512

MB DDR modules)




BIOS

* One 512KB Flash ROM
* Insyde BIOS, Plug and Play (1.0a)

LCD
* 14.1" XGA Flat Panel TFT (1024*768)

Display

* Dynamic Video Memory Technology

* 128 bit 2D/3D Graphics Engine

* Motion Compensation for DVD Accelerator

* Fully DirectX 7/8 Compliant Graphics Engine
* Supports VESA DDCI, DDC2B and DDC 3.0

Specifications
\ A/
S

Video Memory

The system allocates or “shares” a portion of system
memory for video use. “Shared” memory is user-con-
figurable via the SCU. The default setting is set to
32MB (see ).

Storage

* One changeable 12.7mm(h) CD Device Type
Drive

* Easy changeable 2.5" 9.5 mm (h) HDD
Supports Master Mode IDE
Supports LBA Mode
Supports PIO Mode 4
ATA-33/66/100

PC Card
* One Type-II PCMCIA 3.3V/5V Socket

Audio

* AC’97 2.2 Compliant

* Advanced Wavetable Synthesizer
* DirectSound™ 3D Accelerator

* Full-duplex

* Virtual AC3

* Built-In Microphone

* 2 Built-In Speakers




Keyboard Power Management

* A4 Size Win 95 Keyboard * Supports ACPI 2.0
* Built-In TouchPad with Scrolling Function » Power Button as Sleep/Resume Key
 Supports Hibernate Mode
Interface * Supports Standby Mode
« Two USB 2.0/1.1 Ports * Supports Battery Low Sleep Mode
« One Mini- IEEE 1394 Port * Supports Resume From Modem Ring
+ One External VGA Monitor Port * Supports Wake on LAN
* One Headphone-Out Jack
* One Microphone-In Jack Power
* One S/PDIF Output Jack * Full Range AC Adapter
* One TV-Out Jack AC-Input 100~240V, 47~63Hz
* One RJ-11 Jack for Plug & Play Fax/Modem DC Output 20V, 3.25A (65W)
* One RJ-45 Jack for 100M (Max) Fast Ethernet * One 65 Watt Smart Lithium-Ion (6 cells) Battery
* One DC-in Jack Pack
Communication Indicators a
* 56K Plug & Play Fax/Modem V.92 Compliant * LED Indicators (Power/Suspend, Battery, HDD/
* 100M (Max) Fast Ethernet (IEEE 802.3 and CD-ROM, Num Lock, Caps Lock, Scroll Lock,
802.3u Standard Compliant) E-Mail, 802.11b & Bluetooth)

* PC Camera with USB Interface (optional)
» 802.11b Module with USB Interface (optional)
* Bluetooth 1.1 with MDC Interface (optional)



Buttons Optional

* E-Mail  Standard Smart Lithium-lon (65Watt) Battery
* Internet Browser Pack
* Power * 802.11b Module with USB Interface
* Module ON/OFF Button * Bluetooth 1.1 MDC Module
* 2.5" 12.5/12.7mm Height Hard Disk Drive

Environmental Spec * PC Camera with USB Interface
* Temperature

Operating: 5°C ~35°C

Non-Operating: -20°C ~ 60°C
* Relative Humidity

Operating: 20% ~ 80%

Non-Operating: 10% ~ 90%

Physical Dimensions
* 312mm (w) * 263mm (d) * 27.5mm (h) Min

Weight
* 2.5kgw with 14.1" LCD & 6-Cell Battery Pack




Appendix B. Model B Specifications

Processor Options Structure
* Intel Pentium® M - (478-pin) Micro-FCPGA * PC2001 Compliant
package * PCI 2.2 Compliant

. * ACPI 2.0 Compliant
(10.13) 0.13 Micron Process Technology, IMB

On-die L2 Cache & 400MHz PSB - 1.3/ 1.4/ 1.5/

1.6/ 1.7 GHz Security
* Security (Kensington® Type) Lock Slot
* BIOS Password
“ Memory
Rlocssscilvpes * Two 200-pin SODIMM sockets, supporting 200/
You can check your processor type from the POST 266 MHz DDR modules
screen “The Power-On Self Test (POST)” on * Memory expandable up to 1GB (128/ 256/ 512
page 5- 2. MB DDR modules)
Bi0s @
Core Logic * One 512KB Flash ROM
« Intel 855GM + ICH4-M b Insyde BIOS, Plug and Play (IOa)




LCD
* 14.1" XGA Flat Panel TFT (1024*768)

Display

* Dynamic Video Memory Technology

* 128 bit 2D/3D Graphics Engine

* Motion Compensation for DVD Accelerator

¢ Fully DirectX 7/8 Compliant Graphics Engine

* Supports VESA DDCI, DDC2B and DDC 3.0
Specifications

S

Video Memory

The system allocates or “shares” a portion of system
memory for video use. “Shared” memory is user-con-
figurable via the SCU. The default setting is set to
32MB (see )-

Storage

* One changeable 12.7mm(h) CD Device Type
Drive

* Easy changeable 2.5" 9.5 mm (h) HDD
Supports Master Mode IDE
Supports LBA Mode
Supports PIO Mode 4
ATA-33/66/100

PC Card
* One Type-II PCMCIA 3.3V/5V Socket

Audio

* AC’97 2.2 Compliant

* Advanced Wavetable Synthesizer
* DirectSound™ 3D Accelerator

* Full-duplex

* Virtual AC3

* Built-In Microphone

* 2 Built-In Speakers



Keyboard

* A4 Size Win 95 Keyboard
* Built-In TouchPad with Scrolling Function

Interface

* Two USB 2.0/1.1 Ports

* One Mini- IEEE 1394 Port

* One External VGA Monitor Port

* One Headphone-Out Jack

* One Microphone-In Jack

* One S/PDIF Output Jack

* One TV-Out Jack

* One RJ-11 Jack for Plug & Play Fax/Modem

* One RJ-45 Jack for 100M (Max) Fast Ethernet
* One DC-in Jack

Communication

* 56K Plug & Play Fax/Modem V.92 Compliant

* 100M (Max) Fast Ethernet (IEEE 802.3 and
802.3u Standard Compliant)

» PC Camera with USB Interface (optional)

* Intel PRO Wireless LAN 2100 (802.11b) Wire-
less LAN Module with PCI Interface

* Bluetooth 1.1 with MDC Interface (optional)

Power Management

* Supports ACPI 2.0

» Power Button as Sleep/Resume Key
 Supports Hibernate Mode

* Supports Standby Mode

* Supports Battery Low Sleep Mode

* Supports Resume From Modem Ring
* Supports Wake on LAN

Power

* Full Range AC Adapter
AC-Input 100~240V, 47~63Hz
DC Output 20V, 3.25A (65W)

* One 6 cell, 48 Watt, Smart Lithium-Ion Battery
Pack - Approx 3 Hours battery life

* One 12 cell, 96 Watt, Smart Lithium-Ion Battery

Pack (optional) - Approx 6 Hours battery life

Indicators

* LED Indicators (Power/Suspend, Battery, HDD/
CD-ROM, Num Lock, Caps Lock, Scroll Lock,
E-Mail, Wireless LAN & Bluetooth)

B-3



Buttons
* E-Mail
¢ Internet Browser

¢ Power
* Module ON/OFF Button

Environmental Spec
* Temperature

Operating:

Non-Operating:

5°C ~35°C
-20°C ~ 60°C
* Relative Humidity

Operating:
Non-Operating:

20% ~ 80%
10% ~ 90%

Physical Dimensions
* 312mm (w) * 273mm (d) * 27.5mm (h) Min

Weight
* 2.2 kg without Battery

Optional

 Standard Smart Lithium-Ion (48Watt) Battery
Pack

* Bluetooth 1.1 MDC Module

* 2.5" 12.5/12.7mm Height Hard Disk Drive

* Extended Smart Lithium-Ion (96Watt) Battery
Pack

* PC Camera with USB Interface
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